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          ВВЕДЕНИЕ 
 
Данное учебно-методическое пособие используется для знакомства со 

средой графического программирования LabVIEW, а также некоторыми базо-
выми функциями для создания приложений сбора данных и управления прибо-
рами. Первый раздел содержит набор упражнений, помогающих изучить про-
цесс разработки приложений в LabVIEW. Выполнение упражнений не займет 
много времени, зато позволит изучить необходимые базовые функции и начать 
программирование в среде LabVIEW.  

Программы, созданные в среде LabVIEW, называются виртуальными при-
борами или, сокращенно, ВП, потому что их внешний вид и выполняемые ими 
функции схожи с внешним видом и функциями реальных физических прибо-
ров, таких, как осциллограф или мультиметр. Среда LabVIEW содержит обшир-
ный набор инструментальных средств для сбора, анализа, представления и хра-
нения данных, а также инструменты, помогающие отладить создаваемый про-
граммный код.  

Написание программы в LabVIEW начинается с создания интерфейса 
пользователя (или, по-другому, передней панели), содержащего элементы 
управления и индикаторы. Примерами элементов управления являются ручки 
управления, кнопки, круговые шкалы и другие элементы ввода. Индикаторами 
являются графики, светодиодные индикаторы и другие элементы вывода. После 
создания интерфейса пользователя вы можете создать на блок-диаграмме код, 
используя другие виртуальные приборы (ВП) и структуры для управления объ-
ектами лицевой панели.  

Программная среда LabVIEW может применяться для взаимодействия с 
аппаратными средствами, такими, как устройства сбора данных, системы тех-
нического зрения и управления движением, а также GPIB, PXI, VXI, RS232 и 
RS485 устройствами.  

Измерения в LabVIEW. Первый раздел содержит информацию, необходи-
мую при организации сбора и обработки данных с использованием програм- 
много обеспечения LabVIEW. Прежде чем приступить к изучению этого руко-
водства, необходимо обладать некоторыми знаниями основ программирования 
в LabVIEW. Если вы ранее не работали с LabVIEW, рекомендуем ознакомиться с 
руководством Getting Started with LabVIEW (первый запуск LabVIEW).  

Настоящее учебно-методическое пособие дополняет основное руковод-
ство пользователя (LabVIEW User Manual) и предполагает, что вы уже знакомы 
с этим материалом. Вы также должны быть осведомлены о том, как работает 
LabVIEW, операционная система компьютера и устройство сбора данных 
(DAQ). 
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1 ПРАКТИЧЕСКАЯ ЧАСТЬ  
 
1.1 Создание виртуального прибора 
 
Включите персональный компьютер. Запустите программное обеспече-

ние LabVIEW. Для этого дважды щелкните левой кнопкой мыши по значку 
LabVIEW на рабочем столе Windows или выберите в меню Пуск программу 
LabVIEW.  

 
Запуск LabVIEW 
 
При запуске LabVIEW на экране появится окно первоначального запуска 

программного обеспечения Getting Started, показанное на рисунке 1.1. Это окно 
используется при создании нового виртуального прибора на основе заранее со-
зданного шаблона. Окно первоначального запуска Getting Started исчезнет, если 
открыть уже существующий файл или создать новый. Это окно появится снова, 
если закрыть все ранее открытые передние панели и блок-диаграммы виртуаль-
ных приборов. Также это окно можно вызвать в процессе работы из передней 
панели или блок-диаграммы, выбрав меню View → Getting Started Window.  
 

 
 

Рисунок 1.1 – Окно начала работы с лабораторным макетом (Getting Started)  
 

В программном обеспечении LabVIEW смоделированы готовые шаблоны 
ВП, содержащие виртуальные подприборы (подВП), функции, структуры и 
объекты лицевой панели, которые могут потребоваться при создании базовых 
приложений для выполнения различных измерений.  
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Создание нового виртуального прибора из шаблона  
 
Выполните следующие шаги для создания ВП, который генерирует сиг-

нал и отображает его на лицевой панели. 
1. Запустите LabVIEW.  
2. В окне Getting Started щелкните по ссылке New или VI from Template 

(ВП из шаблона), чтобы появилось диалоговое окно New.  
3. Из списка Create New выберите VI «From Template» Tutorial (Getting 

Started) → Generate and Display (ВП из шаблона → Обучение (Введение) → Ге-
нерация и отображение). 

Этот шаблон предназначен для создания ВП, который генерирует и отоб-
ражает сигнал. Предварительный просмотр и краткое описание шаблона ВП 
можно увидеть в разделе Description (Описание).  

На рисунке 1.2 показано диалоговое окно New и эскиз шаблона ВП Гене-
рация и отображение.  

 

 
 

Рисунок 1.2 – Диалоговое окно New 
 

4. Щелкните OK, чтобы создать ВП из шаблона. Также для этого можно 
дважды щелкнуть по названию шаблона ВП в списке Create New.  

5. Изучите лицевую панель ВП. Интерфейс пользователя, или лицевая 
панель, имеет серый фон рабочего пространства и включает элементы управле-
ния и индикаторы. Строка заголовка лицевой панели указывает, что это окно – 
лицевая панель для виртуального прибора «Генерация и Отображение». 

Примечание – Если лицевая панель не видна, можно сделать ее види-
мой/активной/, выбрав меню Window → Show Front Panel (Окно → Показать 
лицевую панель). Вы всегда можете переключиться между окном лицевой пане-
ли и блок-диаграммой, нажав сочетание клавиш <Ctrl_E>.  
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6. Выберите меню Window → Show Block Diagram (Окно → Показать 
блок-диаграмму) и изучите блок-диаграмму ВП.  

Блок-диаграмма имеет белый фон рабочего пространства и содержит ВП 
и структуры, которые управляют объектами лицевой панели. Строка заголовка 
блок-диаграммы указывает, что это окно – блок-диаграмма для ВП «Генерация 
и отображение». 

 7. На панели инструментов интерфейса пользователя 
нажмите кнопку Run (Пуск), показанную на рисунке слева. Для 
запуска ВП можно также нажать комбинацию клавиш <Ctrl_R>.  

На графическом индикаторе лицевой панели отобразится 
синусоида. 

 
8. Для завершения работы с виртуальным прибором 

нажмите кнопку Стоп (расположена в нижнем правом углу пе-
редней панели).  

 
Добавление элемента управления на лицевую панель  
 
Элементы управления передней панели моделируют устройства ввода на 

измерительном приборе и обеспечивают данными блок-диаграмму ВП. Боль-
шинство измерительных приборов имеют ручки управления, поворачивая кото-
рые можно менять входные значения.  

Для добавления ручки управления, необходимо выполнить следующие 
шаги:  

1. Если палитра элементов, показанная на рисунке 1.3, не видна на перед-
ней панели, выберите меню View → Controls Palette.  

Для того чтобы появилась палитра элементов управления или палитра 
функций, можно щелкнуть правой кнопкой мыши на любом свободном месте 
лицевой панели или блок-диаграммы. При этом палитра элементов управления 
или функций появляется со значком «булавки» в левом верхнем углу. Щелкни-
те по нему, чтобы закрепить палитру, и тогда она будет присутствовать посто-
янно.  

Примечание – В процессе выполнения упражнений вы можете отменить 
последние изменения, выбрав опцию Undo в меню Edit или нажав комбинацию 
клавиш <Ctrl-Z>.  

2. Палитра элементов управления по умолчанию появляется с открытой 
подпалитрой Express. Если эта подпалитра не видна, щелкните по Express в па-
литре элементов управления. 

3. Перемещайте курсор мыши по значкам на подпалитре Express, чтобы 
найти подпалитру числовых элементов управления Numeric. Когда вы переме-
щаете курсор по значкам в палитре элементов управления, название подпалит-
ры, элемента управления/индикатора появляется в поле подсказки под значком. 

4. Щелкните по значку Numeric Controls, чтобы отобразить подпалитру 
числовых элементов управления/индикаторов.  
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5. Щелкните по вращающейся ручке (Knob) в палитре Numeric, чтобы 
прикрепить элемент управления к курсору, затем поместите ручку на лицевую 
панель слева от графика. Эта ручка будет использоваться в следующем упраж-
нении для управления амплитудой генерируемого сигнала.  
 

 
 

Рисунок 1.3 – Палитра элементов управления 
 
6. Выберите меню File → Save As (Файл → Сохранить как) и сохраните 

ВП как «Получение сигнала.vi» в заранее определенном месте.  
 
Изменение типа генерируемого сигнала  
 
На блок-диаграмме присутствует значек голубого цвета с названием Simu-

late Signal. Этот значек представляет экспресс-ВП Simulate Signal. По умолча-
нию экспресс-ВП Simulate Signal моделирует синусоиду.  

Выполните следующие шаги, чтобы изменить этот сигнал на пилообраз-
ный.  

1. Перейдите на блок-диаграмму, нажав комбинацию клавиш <Ctrl-E> 
или щелкнув кнопкой мыши по блок-диаграмме.  

Найдите на ней экспресс-ВП Simulate Signal, приведенный на рисунке 1.4.  
Экспресс-ВП − такой элемент блок-диаграммы, который вы можете кон-

фигурировать для выполнения стандартных измерительных задач.  
А именно, экспресс-ВП Simulate Signal моделирует сигнал на основании той 
конфигурации, которую вы зададите.  
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2. Щелкните правой кнопкой мыши по экспресс-ВП Simulate Signal (Мо-
делировать сигнал) и выберите параметр Properties (Свойства) из контекстного 
меню, чтобы отобразить диалоговое окно Configure Simulate Signal (Настройка 
моделируемого сигнала). 

Чтобы появилось диалоговое окно Configure Simulate Signal (Настройка 
моделируемого сигнала), можно также дважды щелкнуть правой кнопкой мыши 
по экспресс-ВП Simulate Signal.  

 

 
 

Рисунок 1.4 – Функция экспресс-ВП – моделирование сигнала 
 
Если подсоединить проводники с входными значениями к экспресс-ВП 

Simulate Signal и запустить его, экспресс-ВП покажет реальные данные в диало-
говом окне настройки. Если закрыть и снова открыть экспресс-ВП, он будет 
показывать пример данных без относительно входных значений в диалоговом 
окне настройки до тех пор, пока ВП не будет снова запущен.  

3. Выберите форму сигнала Sawtooth (Пилообразный сигнал) из меню Sig-
nal type (Тип сигнала). Форма сигнала на графике в разделе предварительного 
просмотра результата изменится на пилообразную. Диалоговое окно Configure 
Simulate Signal (Настройка моделируемого сигнала) должно выглядеть так же, 
как на рисунке 1.5.  

4. Нажмите кнопку ОК, чтобы сохранить текущие настройки, и закройте 
диалоговое окно Configure Simulate Signal.  

5. Наведите курсор мыши на двойные стрелки внизу значка экспресс-ВП 
Simulate Signal. Стрелки показывают, что ВП имеет скрытые входные и выходные 
терминалы, которые можно сделать видимыми, если растянуть границу ВП.  

 

6. Когда появится двунаправленная стрелка, показанная на 
рисунке слева, переместите границу экспресс-ВП так, чтобы до-
бавились две строки.  

После выполнения данной операции появится вход Ampli-
tude (Амплитуда), что дает возможность регулировать амплиту-
ду пилообразного сигнала.  
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Амплитуда − это опция диалогового окна Configure Simulate Signal (см. ри-
сунок 1.5). Когда входы, например амплитуда, присутствуют и на блок-
диаграмме и в диалоговом окне настройки, их значение можно менять в любом 
месте.  

 
 

Рисунок 1.5 – Диалоговое окно Configure Simulate Signal 
 

Соединение объектов на блок-диаграмме  
 
Чтобы использовать вращающуюся ручку для изменения амплитуды сиг-

нала, необходимо соединить ее с входом Amplitude (Амплитуда) экспресс-ВП 
Simulate Signal.  

Для этого выполните следующие шаги:  

 

1. На блок-диаграмме наведите курсор на терминал эле-
мента управления Knob (Вращающаяся ручка), показанный на 
рисунке слева.  

 

При этом курсор мыши станет стрелкой (инструментом 
позиционирования), как показано на рисунке слева. Этот ин-
струмент используется для выбора, размещения или измене-
ния размеров объектов.  

 

2. Выделите терминал Knob (Вращающаяся ручка) с по-
мощью инструмента позиционирования. Убедитесь, что он 
находится слева от экспресс-ВП Simulate Signal и внутри кон-
тура, показанного на рисунке слева и обозначающего цикл.  

Терминалы внутри цикла являются представлением элементов управле-
ния, расположенных на лицевой панели. Терминалы – точки ввода/вывода, че-
рез которые происходит обмен информацией между лицевой панелью и блок-
диаграммой.  
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3. Снимите выделение с терминала Knob (Bращающаяся ручка), щелкнув 
в пустом месте блок-диаграммы.  
 

 

4. Поместите курсор над стрелкой на тер-
минале Knob (Вращающаяся ручка), как показано 
слева. Курсор примет вид катушки, или Wiring 
tool (инструмент Соединение). Используйте этот 
инструмент для соединения объектов на блок-
диаграмме.  

 

5. Когда появится инструмент Соединение, 
щелкните левой кнопкой мыши по стрелке на 
терминале Knob, а затем по стрелке на входе Ам-
плитуда экспресс-ВП Simulate Signal, как показа-
но слева, чтобы соединить эти объекты вместе. 
Появится проводник, соединяющий объекты.  

Данные будут передаваться по этому проводнику от терминала Knob 
(Вращающаяся ручка) к экспресс-ВП.  

6. Выберите меню File → Save (Файл → Сохранить), чтобы сохра-
нить ВП.  

 
Запуск созданного виртуального прибора 
 
Выполните следующие шаги, чтобы запустить ВП «Получение сигнала». 
1. Переключитесь на лицевую панель, нажав комбинацию клавиш 

<Ctrl_E> или щелкнув по ней. 
2. Нажмите кнопку Run (Пуск) или клавиши <Ctrl_R> для запуска ВП.  

 

3. Поместите курсор над ручкой управления. Курсор примет 
вид руки, т. е. перейдет в режим Operating tool (инструмент 
Управление), как показано на рисунке слева. Используйте его, 
чтобы менять значение элемента управления.  

4. Используя инструмент Управление, поверните ручку, чтобы скорректи-
ровать амплитуду пилообразного сигнала.  

Амплитуда пилообразного сигнала изменяется настолько, насколько вы 
поворачиваете ручку. При этом инструмент Управление будет показывать поле 
подсказки, в котором будет отображаться текущее числовое значение. Ось Y на 
графике масштабируется автоматически, подстраиваясь под изменение ампли-
туды.  

 

Чтобы показать, что данный ВП выполняется, кнопка Run 
(Пуск) изменяется на затемненную стрелку, которая показана на 
рисунке слева. Во время выполнения ВП можно изменять значе-
ния большинства элементов управления, но редактировать ВП 
нельзя.  
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5. Чтобы остановить ВП, нажмите кнопку STOP (Стоп), 
которая показана слева. Кнопка STOP останавливает ВП, после 
того как он закончит выполнение текущей итерации. Кнопка 
Abort Execution (Прервать выполнение), которая показана слева, 
останавливает ВП немедленно, до окончания текущей итерации. 
Прерывание работы ВП, использующего внешние ресурсы, 
например внешние аппаратные средства, может оставить ресур-
сы в неизвестном состоянии, не сбросив или не освободив их 
должным образом. Снабдите ВП, который вы создаете, кнопкой 
остановки, чтобы обойти эту проблему.  

 
Преобразование сигнала  
 
Выполните следующие шаги, чтобы увеличить амплитуду сигнала в 10 

раз и вывести результат на график на лицевой панели.  

 

1. На блок-диаграмме, используя инструмент 
Перемещение, дважды щелкните по проводнику, ко-
торый соединяет экспресс-ВП Simulate Signal с тер-
миналом графика осциллограммы (показано слева).  

2. Нажмите клавишу <Delete>, чтобы удалить 
этот проводник.  

3 Если палитра Функции, которая показана на рисунке 1.6, не отображает-
ся, выберите меню View → Functions Palette (Вид → палитра Функции), чтобы 
сделать ее видимой. Палитра Функции по умолчанию открывается вместе с 
подпалитрой Express. Если выбрана другая подпалитра, можно вернуться к 
подпалитре Express, нажав Express в палитре Функции.  

 

4 В палитре Arithmetic & Comparison palette (Арифмети-
ка и сравнение) выберите экспресс-ВП Formula (Формула) 
(показана слева) и разместите его на блок-диаграмме в цикле 
между экспресс-ВП и терминалом графика осциллограммы.  

Можно переместить терминал вправо, чтобы между экспресс-ВП и тер-
миналом было больше места. Когда вы поместите экспресс-ВП на блок-
диаграмме, появится диалоговое окно Configure Formula (Настройка форму-
лы). При размещении экспресс-ВП на блок-диаграмме диалоговое окно 
настройки этого ВП появляется автоматически.  

 

5 Нажмите кнопку Help (Справка), показанную слева, в 
правом нижнем углу диалогового окна Configure Formula 
(Настройка формулы), чтобы отобразить раздел справки 
LabVIEW для этого экспресс-ВП. Данный документ описывает 
экспресс-ВП, опции диалогового окна настройки, а также 
вводы и выводы экспресс-ВП.  

Каждый экспресс-ВП снабжен соответствующей справочной информаци-
ей, к которой можно обратиться, нажав кнопку Help (Справка) в диалоговом 
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окне настройки либо вызвав контекстное меню (щелчок правой кнопкой мыши) 
экспресс-ВП и выбрав пункт Help (Справка).  

 

 
Рисунок 1.6 – Палитра Функции 

 
6. В справочном разделе Formula (Формула), найдите опцию диалогового 

окна, отвечающую за ввод переменных в формулу. 
7. Сверните окно LabVIEW Help, чтобы вернуться к диалоговому окну 

Configure Formula (Настройка формулы).  
8. Измените текст в текстовом поле Label с X1 на Sawtooth, чтобы пере-

именовать входное значение экспресс-ВП Formula. После нажатия кнопкой 
мыши в текстовом поле String вверху диалогового окна Configure Formula текст 
изменится в соответствии с введенным названием.  

9. Задайте масштабный множитель, вводя символы ×10 после слова 
Sawtooth в текстовом поле String.  

Для этого можно использовать кнопки Input (Ввод) в диалоговом окне 
конфигурации либо клавиши *, 1, и 0 на клавиатуре. Если вы используете 
кнопки Input в диалоговом окне конфигурации, LabVIEW помещает символы 
формулы после переменной Sawtooth в текстовом поле String. При использова-
нии клавиатуры, щелкните левой кнопкой мыши в текстовом поле String после 
переменной Sawtooth и введите требуемую формулу. 

Диалоговое окно Configure Formula (Настройка формулы) должно вы-
глядеть так же, как на рисунке 1.7.  

10. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть 
диалоговое окно Configure Formula.  
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11. Поместите курсор над стрелкой на выходе Sawtooth экспресс-ВП 
Simulate Signal.  

 

 
 

Рисунок 1.7 – Диалоговое окно Configure Formula 
 

Примечание – При вводе неправильной формулы в текстовом поле String 
светодиодный индикатор Errors (индикатор Ошибки) в правом верхнем углу 
станет серым и отобразит текст «Invalid Formula» (Неверная формула).  

12. Когда появится инструмент Соединения, щелкните левой кнопкой 
мыши по стрелке на выходе Sawtooth и затем на входе Sawtooth эспресс-ВП 
Formula, чтобы соединить эти объекты.  

13. Используйте инструмент Соединение для соединения выхода Result 
(Результат) экспресс-ВП Formula с терминалом графика осциллограммы.  

Изучите проводники, соединяющие экспресс-ВП и терминалы. Стрелки в 
экспресс-ВП и терминалах показывают направления потоков данных. Блок-
диаграмма должна выглядеть, как показано на рисунке 1.8.  

Примечание – Вы можете щелкнуть правой кнопкой мыши по любому 
проводнику и выбрать опцию Clean Up Wire (оптимизировать проводник) из 
контекстного меню. Для того чтобы LabVIEW автоматически нашла маршрут 
для проводника вокруг объектов, находящихся на блок-диаграмме, LabVIEW 
прокладывает маршрут так, чтобы уменьшить количество изгибов проводника.  
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14. Нажмите комбинацию клавиш <Ctrl-S> или выберите меню 
File → Save (Файл → Сохранить), чтобы сохранить ВП.  

 

 
 

Рисунок 1.8 – Блок-диаграмма ВП Получение сигнала 
 
Отображение двух сигналов на осциллографическом графике  
 
Чтобы на одном графике сравнить сигнал, сгенерированный экспресс-ВП 

Simulate Signal, с сигналом, измененным экспресс-ВП Formula, используйте 
функцию Merge Signals (Объединение сигналов). 

Выполните следующие шаги, чтобы отобразить два сигнала на одном 
графике: 

1. На блок-диаграмме поместите курсор над стрелкой на выходе Sawtooth 
экспресс-ВП Simulate Signal. 

2. Соедините выход Sawtooth с терминалом графика осциллограмм, ис-
пользуя инструмент Соединение.  

 

В месте соединения двух проводников появится функция 
Merge Signals (Объединение сигналов), показанная на рисунке 
слева. Функция – это встроенный исполняемый элемент, анало-
гичный операции, функции или процедуре в текстовом языке 
программирования.  

Функция Merge Signals комбинирует два сигнала таким образом, чтобы 
они могли отображаться на одном графике. 

Блок-диаграмма должна выглядеть, как показано на рисунке 1.9.  
3. Нажмите комбинацию клавиш <Ctrl_S> или выберите меню File → 

Save (Файл → Сохранить), чтобы сохранить ВП. 
4. Переключитесь на лицевую панель, запустите ВП и поверните ручку 

управления. На графике осциллограмм отобразятся пилообразный и усиленный 
сигналы.  
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Максимальное значение по оси Y автоматически изменится, в 10 раз пре-
вышая значение, задаваемое ручкой управления. Масштабирование происходит 
потому, что экспресс-ВП Formula умножает сигнал на 10.  

5. Нажмите кнопку STOP, чтобы остановить ВП.  
 

 
 

Рисунок 1.9 – Блок-диаграмма, демонстрирующая применение функции 
Merge Signals 

 
Настройка ручки управления  
 
Ручка управления изменяет амплитуду пилообразного сигнала, поэтому 

метка «Амплитуда» точно опишет ее назначение. 
Выполните следующие шаги, чтобы настроить внешний вид ручки. 
1. На лицевой панели щелкните правой кнопкой мыши по ручке и выбе-

рите опцию Properties (Свойства) из контекстного меню. Появится диалоговое 
окно Knob Properties (Свойства ручки управления).  

2. В разделе Label (Метка) на вкладке Appearance (Внешний вид) удалите 
из текстового поля текст Knob и введите Амплитуда.  

Диалоговое окно Knob Properties (Свойства ручки управления) должно 
выглядеть, как на рисунке 1.10.  

3. Щелкните по вкладке Scale (Шкала) и в разделе Scale Style (Тип шкалы) 
выделите пункт Show color ramp (Показать градиентную заливку). 

Ручка на лицевой панели обновится в соответствии с этими изменениями. 
4. Щелкните по кнопке OK, чтобы сохранить текущую конфигурацию и 

закрыть диалоговое окно Knob Properties. 
5. Сохраните ВП.  
6. Повторно откройте диалоговое окно Knob Properties и поэксперимен-

тируйте с другими свойствами ручки управления. Например, на вкладке Scale 
попробуйте изменить цвет в поле Marker text color, щелкая по палитре цветов.  
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7. Для отмены сделанных изменений нажмите кнопку Cancel. Для сохра-
нения сделанных изменений нажмите кнопку OK.  

 

 
 

Рисунок 1.10 – Диалоговое окно Knob Properties 
 
На графике осциллограмм в этом случае отображаются два сигнала. Что-

бы указать, какой из графиков соответствует определенному сигналу, графиче-
ский индикатор можно соответственно настроить.  

 
Настройка графика осциллограммы 
 
Выполните следующие шаги, чтобы настроить вид графика осцилло-

грамм. 
1. Поместите курсор на панель редактирования графика. Хотя на графике 

изображено две кривых, на панели редактирования отображается только одна.  
2. Когда появится двунаправленная стрелка, как показано на рисунке 1.11, 

перетащите границу панели редактирования так, чтобы в ней добавилась еще 
одна строчка. Когда вы отпустите кнопку мыши, появится название второго 
графика.  

3. Щелкните правой кнопкой мыши по графику осциллограмм и выберите 
Properties (Свойства) из контекстного меню. Появится диалоговое окно 
Waveform Graph Properties (Свойства графика осциллограмм).  
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4. На вкладке Plots (Графики) выберите Sawtooth из выпадающего меню. 
В разделе Colors (Цвета) щелкните по палитре цветов линии. Выберите новый 
цвет линии.  

5. Выберите Sawtooth (Formula Result) из выпадающего меню. 
6. Выделите галочкой пункт Do not use waveform names for plot names (Не 

использовать названия осциллограмм в качестве названий кривых). 
 

 
 

Рисунок 1.11 – Увеличение панели редактирования 
 

7. В текстовом поле Name удалите текущий ярлык и измените название 
этого графика на «Масштабированный пилообразный сигнал». 

8. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть 
диалоговое окно Waveform Graph Properties (Свойства графика осциллограмм). 

Цвет графиков и их названия на лицевой панели изменятся. 
9. Повторно откройте диалоговое окно Waveform Graph Properties (Свой-

ства графика осциллограмм) и поэкспериментируйте с другими свойствами 
графиков.  

Например, на вкладке Scales попробуйте отключить автоматическое мас-
штабирование по оси Y и изменять максимальное и минимальное значения 
шкалы Y.  

10. Для отмены сделанных изменений нажмите кнопку Cancel. Для со-
хранения сделанных изменений нажмите кнопку OK. 

11. Сохраните и закройте ВП.  
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1.2 Создание виртуального прибора из пустого ВП  
 
Включите персональный компьютер. Запустите программное обеспечение 

LabVIEW. Для этого дважды щелкните левой кнопкой мыши по значку 
LabVIEW на рабочем столе Windows или выберите в меню Пуск программу 
LabVIEW.  

Выполните следующие операции для создания электронного осциллогра-
фа из пустого ВП (Blank VI):  

1. В окне первоначального запуска Getting Started щелкните по ссылке 
Blank VI (Пустой ВП) в разделе New (Новый) или нажмите сочетание клавиш 
<Ctrl_N>.  

Появятся пустые окна лицевой панели и блок-диаграммы.  
Примечание – Пустой ВП можно открыть также, если выбрать меню 

File → New VI (Файл → Новый ВП) или File → New (Файл → Новый) и выбрать 
Blank VI (Пустой ВП) из списка Create New (Создать новый).  

2. Если палитра функций (Functions palette) не видна, щелкните правой 
кнопкой мыши в любом свободном месте блок-диаграммы. Щелкните по знач-

ку «булавки»  в левом верхнем углу палитры функций, чтобы закрепить 
палитру, и тогда она будет присутствовать постоянно.  

Выполните следующие шаги для поиска необходимого экспресс-ВП и до-
бавления его на блок-диаграмму.  

Выберите меню Help → Show Context Help (Помощь → Показать окно 
контекстной справки) на лицевой панели или блок-диаграмме, чтобы отобра-
зить окно контекстной справки, которое показано на рисунке 1.12. Также для 
этого можно нажать кнопку «Show Context Help Window» (Показать окно кон-
текстной справки), которая отображается на панели инструментов лицевой па-
нели или блок-диаграммы.  

 

 
 

Рисунок 1.12 – Окно контекстной справки  
 

3. В палитре Функции выберите Express → Input palette (Экспресс → па-
литра Ввод) и наведите указатель мыши на один из экспресс-ВП в палитре 
Input. При наведении указателя на ВП окно Контекстная справка покажет ин-
формацию об этом ВП.  
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4. Используйте информацию, которая появляется в окне контекстной 
справки, чтобы найти экспресс-ВП, который может моделировать синусоидаль-
ный сигнал.  

Оставьте окно Контекстная справка открытым. Контекстная справка бу-
дет снабжать вас полезной информацией, пока вы выполняете оставшуюся 
часть данного упражнения.  

5. Выберите экспресс-ВП и поместите его на блок-диаграмму. На экране 
появится диалоговое окно Configure Simulate Signal (Настройка моделируемого 
сигнала).  

6. Перемещайте курсор по различным опциям в диалоговом окне 
Configure Simulate Signal (Настройка моделируемого сигнала), таким как 
Frequency (Частота) в герцах и Amplitude (Амплитуда). Просматривайте ин-
формацию, которая появляется в окне контекстной справки. 

7. Настройте экспресс-ВП Simulate Signal (Моделирование сигнала) так, 
чтобы он моделировал синусоиду с частотой 10,7 Гц и амплитудой 2 В.  

Сигнал в окне «Result Preview» (Предварительный просмотр результа-
та) изменится и отобразит смоделированную синусоиду.  

8. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть 
диалоговое окно Configure Simulate Signal (Настройка моделируемого сигнала). 

9. Поместите курсор мыши над экспресс-ВП Simulate Signal и посмотрите 
информацию, которая появится в окне контекстной справки. Окно Контекст-
ная справка отобразит информацию о настройках экспресс-ВП Simulate Signal.  

10. Сохраните ВП под именем Reduce Samples.vi в заранее определенном 
месте.  

 
Поиск справочной информации и изменение сигнала  
 
Выполните следующие шаги по поиску справочной информации и изме-

нению сигнала, чтобы с помощью справки LabVIEW Help найти экспресс-ВП, 
уменьшающий количество выборок в сигнале.  

1. Наведите указатель мыши на экспресс-ВП Simulate Signal и щелкните 
по ссылке Detailed help (Детализированная справка) в окне Контекстная 
справка, чтобы отобразить раздел Simulate Signal (Моделирование сигнала) 
справки LabVIEW Help. Возможно, вам придется увеличить размер окна или 
прокрутить вниз окно Контекстная справка, чтобы увидеть ссылку Detailed 
help (Детализированная справка).  

Вы также можете обратиться к справке LabVIEW Help, щелкнув правой 
кнопкой мыши по ВП или функции на блок-диаграмме, или в прикрепленной 
палитре и выбрав пункт Help (Справка) из контекстного меню или выбрав меню 
Help → Search the LabVIEW Help (Помощь → Найти в LabVIEW Help).  

2. Щелкните по вкладке Search (Поиск), введите фразу «sample compres-
sion» в строке Type in the word(s) to search for (Введите слово для поиска) и 
нажмите клавишу <Enter>. Чтобы найти фразу целиком, нужно взять ее в ка-
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вычки. Например, чтобы сузить результаты поиска, введите «Sample 
Compression». Эта фраза показывает, что нам необходимо от экспресс-ВП – 
сжатие (compression) или прореживание количества выборок в сигнале.  

3. Дважды щелкните по разделу Sample compression в результатах поиска, 
чтобы отобразить раздел, который описывает экспресс-ВП Sample compression. 

4. После того как вы прочитаете описание экспресс-ВП, нажмите кнопку 
«Place on the block diagram» (Разместить на блок-диаграмме), чтобы прикре-
пить экспресс-ВП к указателю мыши.  

5. Переместите указатель мыши на блок-диаграмму. 
6. Разместите экспресс-ВП Sample compression на блок-диаграмме справа 

от экспресс-ВП Simulate Signal. 
7. Настройте экспресс-ВП Sample compression так, чтобы проредить сиг-

нал с коэффициентом 25 относительно его среднего значения. 
8. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть 

диалоговое окно Configure Sample Compression. 
9. Используйте инструмент Соединение, чтобы соединить выход Sine (Си-

нус) экспресс-ВП Simulate Signal со входом Signals (Сигналы) экспресс-ВП 
Sample compression.  

 
Настройка интерфейса пользователя на блок-диаграмме 
 
Проведите настройку интерфейса пользователя на блок-диаграмме. Для 

этого выполните следующие шаги:  
1. На блок-диаграмме щелкните правой кнопкой мыши по выходу Mean 

(Среднее) экспресс-ВП Sample compression и выберите опцию Create → Numeric 
Indicator (Создать → Числовой индикатор) из контекстного меню, чтобы со-
здать числовой индикатор.  

 

Числовой индикатор Mean (Среднее), который показан слева, 
появится на блок-диаграмме.  

Щелкните правой кнопкой мыши по выходу Mean (Среднее) 
экспресс-ВП Sample compression. 

2. Выберите опцию Insert Input/Output (Добавить ввод/вывод) из кон-
текстного меню, чтобы добавить входной терминал Enable (Включить).  

В предыдущем упражнении добавлялись вводы и выводы, растягивая 
границу экспресс-ВП с помощью стрелок. Использование контекстного меню – 
другой способ сделать вводы и выводы доступными для просмотра и выбора.  

 

3. Щелкните правой кнопкой мыши по входу Enable (Включить) 
и выберите пункт Create → Control (Создать → Элемент управле-
ния) из контекстного меню, чтобы создать выключатель. Терминал 
логического элемента управления (показан на рисунке слева) появит-
ся на блок-диаграмме.  
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Терминалы элементов управления имеют контур большей толщины, чем 
терминалы элементов отображения. Кроме этого, стрелка на терминале элемен-
та управления появляется справа, а на терминале индикатора – слева. 

4. Щелкните правой кнопкой мыши по проводнику, который соединяет 
выход Sine (Синус) экспресс-ВП Simulate Signal со входом Signals (Сигналы) 
экспресс-ВП Sample compression, выберите опцию Create → Graph Indicator 
(Создать → Графический индикатор) из контекстного меню.  

5. Используйте инструмент Соединение, чтобы соединить выход Mean 
(Среднее) экспресс-ВП Sample compression с графическим индикатором Sine 
(Синус). Появится Функция Merge Signals (Объединение сигналов).  

6. Расположите объекты на блок-диаграмме, как показано на рисун-
ке 1.13.  

7. Переключитесь на лицевую панель.  
Добавленные элементы Управления (Сontrols) и Индикаторы (Indicators) 

появились на лицевой панели и имеют ярлыки, соответствующие тем вводам и 
выводам ВП, для которых вы их создавали.  

Примечание – Возможно, вам понадобится изменить размеры лицевой 
панели, чтобы увидеть все элементы управления и индикаторы. 

8. Сохраните ВП.  
 

 
Рисунок 1.13 – Блок-диаграмма ВП Reduce Samples 

 
Настройка непрерывного выполнения ВП до остановки его пользователем 
 
Проведите настройку непрерывного выполнения программы виртуально-

го прибора до остановки его пользователем. 
В текущей версии ВП запускается один раз, генерирует сигнал и заканчи-

вает свое выполнение. Чтобы ВП выполнялся до определенного момента, мож-
но использовать цикл While (While Loop).  
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Выполните следующие шаги, чтобы добавить цикл While (While Loop) на 
блок-диаграмму. 

1. Активируйте лицевую панель и запустите ВП. 
ВП выполнится один раз и затем остановится. На лицевой панели нет 

кнопки остановки. 
2. Переключитесь на блок-диаграмму. 
3. Нажмите кнопку Search (Найти), которая показана слева, на палитре 

Функции, и введите слово While в текстовое поле. LabVIEW ищет слова, кото-
рые вы набрали, и отображает любые совпадения в текстовом поле результатов 
поиска. В поле результатов поиска слева от названия подпалитры будет отоб-
ражаться символ папки, а в случае экспресс-ВП это будет значок ВП на голу-
бом фоне.  

4. Дважды щелкните по While Loop «Execution Control» (цикл While 
«Управление выполнением»), чтобы отобразить подпалитру Execution Control и 
цикл While.  

5. Выберите цикл While (While Loop) в палитре Execution Control. 
6. Поместите указатель мыши в верхний левый угол блок-диаграммы. 

Щелкните по нему, чтобы «закрепить» верхний левый угол цикла While.  
7. Переместите указатель мыши по диагонали так, чтобы охватить все 

экспресс-ВП и проводники, как показано на рисунке 1.14.  
 

 
 

Рисунок 1.14 – Размещение экспресс-ВП внутри цикла While 
 

 

8. Еще раз щелкните кнопкой мыши, чтобы создать цикл 
While, охватывающий экспресс-ВП и проводники. Цикл 
While, который показан на рисунке слева, появится сов-
местно c кнопкой Стоп (STOP), соединенной с термина-
лом Условия выхода (Conditional Terminal). Этот цикл бу-
дет останавливаться при нажатии кнопки Стоп (STOP).  
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9. Переключитесь на лицевую панель и выполните ВП. Теперь ВП будет 
выполняться до тех пор, пока вы не нажмете кнопку Стоп (STOP). 

10. Нажмите кнопку Стоп (STOP) и сохраните ВП.  
 
Использование окна Список ошибок (Error List)  
 
Если ВП содержит ненужные индикаторы, вы можете их удалить. Вы-

полните следующие шаги, чтобы удалить индикатор Mean (Среднее) с лицевой 
панели. 

1. На лицевой панели поместите курсор над индикатором Mean (Среднее) 
и дождитесь, пока появится инструмент Позиционирование (Positioning tool).  

 

2. Щелкните по индикатору Mean (Среднее), который пока-
зан слева, выделите его и нажмите клавишу <Delete>. 

3. Переключитесь на блок-диаграмму.  

 

 

Проводник теперь выглядит как черная штриховая линия с крас-
ным крестиком посередине (показано слева). Линия такого вида – это 
неисправный проводник. Кнопка Пуск (Run) принимает вид сломанной 
стрелки (показана слева), чтобы указать, что этот ВП нельзя запустить. 

4. Нажмите неисправную кнопку Пуск (Run), чтобы вывести на экран ок-
но Error list (Список ошибок), в котором перечислены все допущенные ошибки 
в ВП и написана детальная информация о каждой ошибке. Кроме этого, окно 
Error list (Список ошибок) можно использовать, чтобы определить местонахож-
дение ошибки.  

5. В списке Errors and warnings (Ошибки и предупреждения) выберите 
пункт Wire: has loose ends (Провод: имеет свободный конец) и нажмите кнопку 
Help (Справка), чтобы вывести на экран подробную информацию об ошибке.  

Примечание – Чтобы вывести на экран подсказку с описанием неисправно-
сти, вы можете поместить инструмент Соединение («катушка») на неисправный 
проводник. Эта информация также появляется в окне Контекстная справка.  

6. В списке Errors and warnings (Ошибки и предупреждения) дважды 
щелкните по пункту Wire: has loose ends (Провод: имеет свободный конец), 
чтобы выделить неисправный проводник.  

7. Нажмите сочетание клавиш <Ctrl-B>, чтобы его удалить.  
Нажатием клавиш <Ctrl-B> стираются все неисправные проводники на 

блок-диаграмме. Чтобы стереть только выделенный проводник, нажмите кла-
вишу <Delete>.  

8. Выберите View → Error List (Показать → Список ошибок), чтобы вы-
вести на экран окно списка ошибок. Теперь список пуст.  

Примечание – Для того чтобы вывести на экран окно списка ошибок, 
можно нажать сочетание клавиш <Ctrl-L>. 

9.Нажмите кнопку Close, чтобы закрыть окно списка ошибок. Кнопка Run 
теперь будет работоспособна.  
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Управление скоростью выполнения программы  
 
Чтобы строить точки на графике осциллограмм более медленно, необхо-

димо добавить на блок-диаграмму временную задержку.  
Выполните следующие шаги, чтобы иметь возможность управлять скоро-

стью выполнения ВП. 
1. В палитре Функции на блок-диаграмме найдите экспресс-ВП Time 

Delay (Временная задержка) и поместите его в цикл While. Он предназначен 
для управления скоростью выполнения ВП.  

2. Введите значение 0,25 в текстовое поле Time delay (Время задержки)  
(в секундах). Это значение определяет, как часто будет выполняться цикл. Если 
время задержки равно 0,25 с, цикл будет выполнять итерацию раз в четверть 
секунды.  

3. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть 
диалоговое окно Configure Time Delay (Настроить временную задержку). 

4. Переключитесь на лицевую панель и запустите ВП. 
5. Переключите элемент управления Enable и изучите изменения на гра-

фике. Если переключатель включен, график будет отображать прореженный 
сигнал. 

6. Нажмите кнопку STOP (Стоп), чтобы остановить ВП.  
 
Использование таблиц для вывода данных на экран 
 
Выполните следующие шаги для отображения набора средних значений в 

таблице на лицевой панели. 
1. В палитре Элементы управления (Controls palette) на лицевой панели 

найдите индикатор Express Table и поместите его на лицевую панель справа от 
графика осциллограмм. 

2. Переключитесь на блок-диаграмму. LabVIEW автоматически соединил 
терминал Table (Таблица) с экспресс-ВП Build Table (Построение таблиц).  

 

3. Если экспресс-ВП Build Table и терминал 
Table (Таблица) еще не выделены, щелкните по сво-
бодному месту блок-диаграммы слева от экспресс-ВП 
Build Table и терминала Table (Таблица). Переместите 
указатель мыши по диагонали, пока прямоугольник 
области выделения не охватит их, как показано слева.  

При этом экспресс-ВП Build Table, терминал Table (Таблица) и проводник 
между ними будут охвачены двигающимся пунктирным контуром.  

4. Переместите эти объекты в цикл While справа от экспресс-ВП Sample 
Compression.  

Если переместить объекты около границы цикла While цикл изменит раз-
меры, чтобы включить в себя экспресс-ВП Build Table и терминал «Таблицы». 
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При размещении объекта около границы цикла последний изменяет раз-
меры, чтобы добавить место для этого объекта. 

4. Используйте инструмент Соединение («Катушка»), чтобы присоеди-
нить выход Mean (Среднее) экспресс-ВП Sample Compression к входу Signals 
(Сигналы) экспресс-ВП Build Table. Блок-диаграмма должна выглядеть, как по-
казано на рисунке 1.15.  

 

 
 

Рисунок 1.15 – Блок-диаграмма ВП Reduce Samples 
 

6. Переключитесь на лицевую панель и запустите ВП. 
7. Щелкните переключателем Enable. 
Если переключатель Enable включен, таблица будет отображать средние 

значения каждых 25 выборок синусоиды. Если он выключен, таблица не будет 
записывать средние значения. 

8. Остановите ВП.  
9. Поэкспериментируйте со свойствами таблицы, используя диалоговое 

окно Table Properties (Свойства таблицы). Например, попробуйте изменить 
число столбцов до одного.  

10. Сохраните и закройте ВП.  
 
Поиск примеров 
 
Выполните следующие шаги, чтобы найти и открыть пример, который 

использует экспресс-ВП Time Delay (Временная задержка). 
1. Выберите меню Help → Search the LabVIEW Help (Справка → Поиск в 

справке LabVIEW), чтобы вывести на экран справку LabVIEW Help.  
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2. Щелкните по вкладке Search, введите «Time Delay» (Временная за-
держка) в текстовое поле Type in the word(s) to search for (Введите слова для 
поиска) и нажмите клавишу <Enter>. 

Прежде чем искать пример, можно сузить область поиска, поставив га-
лочку Search titles only (Искать только в заголовках) снизу в окне справки. 
Также можно использовать операторы, такие как AND (И), OR (ИЛИ) и NEAR 
(Почти) в текстовом поле Type in the word(s) to search for. Для получения до-
полнительной информации о поиске обратитесь к книге Using Help (Использо-
вание справки) во вкладке Contents (Содержание) справки LabVIEW Help.  

3. Щелкните по заголовку столбца Location (Расположение), чтобы от-
сортировать результаты поиска по содержанию. Разделы Reference (Справочная 
информация) содержат базовую информацию об объектах LabVIEW, таких как 
ВП, функции, палитры, меню, инструменты. Разделы How_To (Практические 
рекомендации) содержат пошаговые инструкции по пользованию LabVIEW.  

Разделы Concept (Концепции) содержат информацию о концепциях про-
граммирования в LabVIEW.  

4. Дважды щелкните по результату поиска Time Delay (Время задержки), 
чтобы вывести на экран раздел справки, описывающий экспресс-ВП Time 
Delay. 

5. После того как вы прочитаете описание экспресс-ВП, нажмите кнопку 
Open example (Открыть пример) в разделе Example (Пример) внизу раздела, 
чтобы открыть пример, который использует экспресс-ВП Time Delay. 

6. Нажмите кнопку Browse related examples (Просмотреть похожие при-
меры), чтобы открыть NI Example Finder (Поисковик примеров) и вывести на 
экран список примеров, в которых используется этот ВП. Поисковик осуществ-
ляет поиск среди сотен примеров, включая все установленные на компьютер 
примеры, а также примеры из ресурса NI Developer Zone на сайте ni.com/zone.  

Вы можете скорректировать пример под необходимое приложение или 
скопировать и вставить один или более примеров в ВП, который создаете. Вы 
также можете щелкнуть правой кнопкой мыши по ВП или функции на блок-
диаграмме или на прикрепленной палитре и выбрать Examples (Примеры) из 
контекстного меню, чтобы вывести на экран раздел справки со ссылками на 
примеры для этого ВП или функции. 

Запустите Поисковик примеров NI и просмотрите или поищите примеры, 
выбрав меню Help → Find Examples (Справка → Найти примеры) или щелкнув 
по ссылке Find Examples (Найти примеры) в разделе Examples (Примеры) окна 
Getting Started. 

5. После того как вы поэкспериментируете с поисковиком примеров NI и 
примерами ВП, закройте их.  

После завершения выполнения упражнения лицевая панель ВП должна 
выглядеть, как показано на рисунке 1.16.  
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Рисунок 1.16 – Лицевая панель ВП Reduce Samples 
 

1.3 Создание ВП для анализа сигналов  
 
Целью данного упражнения является создание ВП, который генерирует 

сигнал, фильтрует его, индицирует превышение сигналом определенного пре-
дела и сохраняет данные.  

 
Изменение ВП, созданного из шаблона  
 
Выполните следующие шаги для создания ВП, который генерирует сиг-

нал, анализирует его и выводит на экран.  
1. В окне Getting Started нажмите New, чтобы появилось диалоговое окно 

New. 
2. Из списка Create New выберите пункты VI → From Template → Tutorial 

(Getting Started) → Generate, Analyze, and Display. Этот шаблон ВП моделирует 
сигнал и анализирует его СКО (среднеквадратичное отклонение) (RMS).  

3. Нажмите кнопку OK или дважды щелкните по названию шаблона, что-
бы создать ВП из шаблона.  

4. Если окно Context Help (Контекстной справки) закрыто, нажмите соче-
тание клавиш <Ctrl_H>.  

 

5. Переключитесь на блок-диаграмму, одновременно нажав 
сочетание клавиш <Ctrl-E>.  
6. Поместите курсор мыши над экспресс-ВП Amplitude and 
Level Measurements, показанным на рисунке слева. Окно спра-
вочных данных будет содержать информацию о характеристи-
ках этого ВП.  
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Оставьте окно контекстной справки открытым. Оно будет снабжать вас 
полезной информацией во время выполнения оставшейся части упражнения. 

7. На блок-диаграмме удалите индикатор RMS (СКЗ), а также некоторые 
неисправные проводники на блок-диаграмме, которые появились из-за выпол-
нения этой операции. Чтобы удалить все неисправные проводники на блок-
диаграмме, нужно нажать сочетание клавиш <Ctrl-B>.  

8. На лицевой панели щелкните правой кнопкой мыши по графику осцил-
лограмм и выберите опцию Properties (Свойства) из контекстного меню. На 
экране появится диалоговое окно Graph Properties. 

9. На вкладке Appearance отметьте галочкой пункт Visible в разделе Label 
(Ярлык) и введите Unfiltered Signal (Необработанный сигнал) в текстовое поле. 

10. Нажмите кнопку OK, чтобы сохранить настройки и закрыть диалого-
вое окно Graph Properties. 

11. Запустите ВП. Сигнал появится на графике. 
12. Нажмите кнопку STOP, чтобы остановить ВП.  
 
Сложение сигналов  
 
Выполните следующие шаги для создания дополнительного моделируе-

мого сигнала, который добавит к синусоиде однородный белый шум.  
1. На блок-диаграмме с помощью инструмента Перемещение «Стрелка» 

выделите экспресс-ВП Simulate Signal.  
Для создания еще одного экспресс-ВП Simulate Signal перемещайте его, 

одновременно удерживая клавишу <Ctrl>. При перемещении удерживайте ле-
вую кнопку мыши.  

2. Поместите копию экспресс-ВП Simulate Signal под оригиналом и отпу-
стите кнопку мыши. Среда LabVIEW заменит имя скопированного экспресс-ВП 
Simulate Signal на Simulate Signal2.  

3. Дважды щелкните по экспресс-ВП Simulate Signal2, чтобы появилось 
диалоговое окно настройки Configure Simulate Signal. 

4. Выберите Sine (Синус) из выпадающего меню Signal type (Тип сигнала). 
5. В текстовом поле Frequency (Hz) введите значение 60. 
6. В текстовом поле Amplitude введите значение 0.1. 
7. Пометьте пункт Add noise, чтобы добавить шум к синусоиде. 
8. Выберите пункт Uniform White Noise (Однородный белый шум) из вы-

падающего меню Noise type (Тип шума). 
9. В текстовом поле Noise amplitude (Амплитуда шума) введите значе-

ние 0,1. 
10. В текстовом поле Seed number введите значение 1. 
11. В разделе Timing (Синхронизация) выберите опцию Run as fast as pos-

sible (Выполняться максимально быстро). 
12. В разделе Signal Name (Название сигнала) удалите отметку с пункта 

Use signal type name. 
13. В текстовом поле Signal name введите 60 Hz and Noise. 
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При изменении названия сигнала в окне Configure Simulate Signal среда 
LabVIEW меняет название выходного терминала, что облегчает идентификацию 
типа сигнала при просмотре экспресс-ВП на блок-диаграмме.  

Раздел Result Preview (Предварительный просмотр результата) отобра-
жает случайный сигнал. Диалоговое окно Configure Simulate Signal (Настройка 
моделируемого сигнала) должно выглядеть так же, как на рисунке 1.17.  

 

 
 

Рисунок 1.17 – Диалоговое окно Configure Simulate Signal 
 

14. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть 
диалоговое окно Configure Simulate Signal.  

 
Сложение двух сигналов 
 
Чтобы создать один сигнал как сумму двух других, можно воспользовать-

ся экспресс-ВП Formula (Формула). В частности, мы будем использовать экс-
пресс-ВП Formula для добавления шума к сигналу.  

Выполните следующие шаги, чтобы добавить сигнал 60 Hz and Noise к 
сигналу Sine.  
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1. На блок-диаграмме трижды щелкните по проводнику, соединяющему вы-
ход Sine (Синус) экспресс-ВП Simulate Signal, вход экспресс-ВП Amplitude and 
Level Measurements и индикатор Unfiltered Signal, и удалите этот проводник.  

2. Нажмите кнопку Search (Поиск) в палитре функций, чтобы найти экс-
пресс-ВП Formula и поместите его на блок-диаграмму между экспресс-ВП 
Simulate Signal и экспресс-ВП Amplitude and Level Measurements.  

3. В появившемся диалоговом окне Configure Formula в столбце Label из-
мените ярлык для входа X1 на Sine, а для X2 на 60 Hz and Noise. 

4. Нажмите кнопки Input и «+», чтобы сложить Sine и 60 Hz and Noise, за-
писав эту операцию в текстовом поле String.  

5. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть 
диалоговое окно Configure Formula.  

6. Используйте инструмент Соединение «Катушка», чтобы соединить вы-
ход Sine экспресс-ВП Simulate Signal с входом Sine экспресс-ВП Formula. 

7. Соедините выход 60 Hz and Noise экспресс-ВП Simulate Signal 2 с вхо-
дом 60 Hz and Noise экспресс-ВП Formula.  

8. Соедините выход Result (Результат) экспресс-ВП Formula с индикато-
ром Unfiltered Signal и входом Signals экспресс-ВП Amplitude and Level Meas-
urements. 

9. Переключитесь на лицевую панель, нажав комбинацию клавиш 
<Ctrl_E>. 

10. Запустите ВП. На графике появится сигнал с добавленным шумом. 
11. Нажмите кнопку STOP, чтобы остановить ВП. 
12. Выберите меню File → Save As (Файл → Сохранить как) и сохраните 

ВП как Analysis.vi в заранее определенном месте. 
 
Фильтрация сигнала 
 
Для обработки сигналов с помощью фильтров и окон можно использовать 

экспресс-ВП Filter (Фильтр). Выполните следующие шаги, чтобы настроить 
экспресс-ВП Filter так, чтобы он производил обработку сигнала с помощью IIR 
(БИХ – с бесконечной импульсной характеристикой) фильтра.  

1. Удалите проводник, который соединяет выход Result (Результат) экс-
пресс-ВП Formula с входом Signals экспресс-ВП Amplitude and Level Measure-
ments.  

2. Удалите все оставшиеся неисправные проводники.  

 

3. Найдите экспресс-ВП Filter и поместите его на блок-
диаграмму между экспресс-ВП Simulate Signal 2 и экспресс-ВП 
Amplitude and Level Measurements. На экране появится диало-
говое окно Configure Filter. 

4. В разделе Filter Specifications (Характеристики фильтра) измените 
Cutoff Frequency (Частота среза) в герцах на 25.  
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5. Нажмите кнопку OK, чтобы сохранить настройки и закрыть диалоговое 
окно Configure Filter. 

6. Переключитесь на лицевую панель.  
7. На лицевой панели щелкните по индикатору Unfiltered Signal и, удер-

живая нажатой клавишу <Ctrl>, переместите его, чтобы создать еще один гра-
фик осциллограмм.  

8. Поместите созданный график осциллограмм под исходным. 
9. Трижды щелкните по ярлыку Unfiltered Signal 2 выше нового графика 

осциллограмм и введите Filtered Signal. Также можно изменить ярлык на 
вкладке Appearance (Вид) диалогового окна Graph Properties.  

10. На блок-диаграмме соедините выход Result (Результат) экспресс-ВП 
Formula с входом Signal (Сигнал) экспресс-ВП Filter. 

11. Соедините выход Filtered Signal экспресс-ВП Filter с входом Signal 
экспресс-ВП Amplitude and Level Measurements и с терминалом графика осцил-
лограмм Filtered Signal. 

12. Выберите меню File → Save (Файл → Сохранить).  
Блок-диаграмма ВП Analysis должна выглядеть так, как показано на ри-

сунке 1.18.  
 

 
 

Рисунок 1.18 – Блок-диаграмма ВП Analysis 
 

Изменение вида графиков 
 
Выполните следующие шаги, чтобы изменить формат шкал X и Y для 

графиков Unfiltered Signal и Filtered Signal. 
1. На лицевой панели щелкните правой кнопкой мыши по графику 

Unfiltered Signal и выберите пункт Properties (Свойства) из контекстного меню. 
На экране появится диалоговое окно Graph Properties.  
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2. На вкладке Format and Precision выберите Time (X_Axis) (Время) над 
выпадающим меню.  

3. В списке Type (Тип) выберите Automatic formatting (Автоформатиро-
вание).  

4. В поле Digits введите 6 и выберите пункт Significant digits (Значащие 
цифры) из выпадающего меню Precision Type (Тип точности). 

5. Отметьте пункт Hide trailing zeros (Скрыть лишние нули). 
6. Выберите пункт Amplitude (Y_Axis) (Амплитуда) над выпадающим ме-

ню и повторите шаги 3–5. Теперь настройки оси Y соответствуют оси X.  
7. На вкладке Scales (Масштаб) выберите пункт Amplitude (Y_Axis) (Ам-

плитуда). 
8. Удалите отметку с пункта Autoscale. 
9. В текстовое поле Minimum введите значение минус 2,5, в Maximum – 

значение 2,5.  
10. Нажмите кнопку OK, чтобы сохранить настройки и закрыть диалого-

вое окно Graph Properties. 
11. Повторите шаги 1–10, чтобы настроить вид графика Filtered Signal. 

Оси X и Y на графиках Unfiltered Signal и Filtered Signal изменятся, отражая 
сделанные изменения.  

 
Анализ амплитуды сигнала  
 
Для анализа изменения сигнала можно использовать экспресс-ВП 

Amplitude and Level Measurements. 
Выполните следующие шаги, чтобы настроить экспресс-ВП для измере-

ния амплитуды сигнала. 
1. На блок-диаграмме дважды щелкните по экспресс-ВП Amplitude and 

Level Measurements, чтобы появилось диалоговое окно Configure Amplitude and 
Level Measurements. 

2. В разделе Amplitude Measurements (Измерение амплитуды) удалите от-
метку с пункта RMS (СКЗ).  

 

3. Отметьте пункт Peak to peak. В разделе Results 
(Результаты) с соответствующим измеренным значе-
нием появится Peak to peak.  

4. Нажмите кнопку OK, чтобы сохранить текущие 
настройки и закрыть диалоговое окно Configure Ampli-
tude and Level Measurements. Выход RMS экспресс-ВП 
Amplitude and Level Measurements изменится на выход 
Peak to peak, как показано на рисунке слева.  
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Управление скоростью выполнения программы  
 
Чтобы точки на графике появлялись медленнее, необходимо добавить за-

держку на блок-диаграмму. 
Выполните следующие шаги, чтобы управлять скоростью, с которой вы-

полняется ВП.  
1. Найдите экспресс-ВП Time Delay (Временная задержка).  
2. Поместите его в нижний левый угол Цикла While. На экране появится 

диалоговое окно Configure Time Delay.  
3. В текстовое поле Time delay (seconds) введите значение 0,1 и нажмите 

кнопку OK. 
4. Запустите ВП. Цикл будет выполняться с частотой 10 итераций в се-

кунду. 
5. Остановите ВП. 
 
Добавление предупредительной световой сигнализации  
 
Для индикации события, заключающегося в превышении сигналом опре-

деленного значения, необходимо использовать световую сигнализацию. 
Выполните следующие шаги, чтобы добавить в ВП световую сигнализа-

цию. 
1. Щелкнув правой кнопкой мыши по любому свободному месту лицевой 

панели, вызовите палитру элементов управления. 
2. В подпалитре Express выберите подпалитру светодиодных индикато-

ров, внешний вид которой показан на рисунке 1.19.  
 

 
 

Рисунок 1.19 – Палитра светодиодных индикаторов 
 

3. Выберите круглый светодиодный индикатор и поместите его на лице-
вую панель слева от графиков.  

4. Дважды щелкните по ярлыку Boolean над индикатором и измените его 
на Warning (Предупреждение).  
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Данный светодиодный индикатор будет использоваться позже для инди-
кации превышения заданного предела. 

5. Выберите меню File → Save (Файл → Сохранить как), чтобы появи-
лось диалоговое окно Save As. 

6. Просмотрите различные опции этого диалогового окна. Выберите оп-
цию Copy (Копировать) и выделите пункт Substitute copy for original, чтобы со-
здать копию исходного ВП и начать ее редактировать. 

7. Нажмите кнопку Continue и сохраните ВП как Warning Light.vi в зара-
нее определенном месте.  

 
Настройка предельного значения 
 
Для определения значения, при котором светодиодный индикатор будет 

включаться, используйте экспресс-ВП Comparison (Сравнение). 
Выполните следующие шаги, чтобы сравнить полное значение амплиту-

ды с задаваемым пределом.  
1. Найдите экспресс-ВП Comparison и поместите его справа от экспресс-ВП 

Amplitude and Level Measurements. На экране появится диалоговое окно Config-
ure Comparison.  

2. В разделе Compare Condition (Условия сравнения) выберите опцию 
Greater (>) (Больше). 

3. В разделе Comparison Inputs выберите Value и введите 2 в текстовое 
поле Value, чтобы задать постоянное значение, при котором светодиод будет 
гореть. 

4. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть 
диалоговое окно Configure Comparison.  

 

Название экспресс-ВП Comparison изменится, отражая 
выполняемую операцию, как показано слева. Название Greater 
(Больше) указывает, что экспресс-ВП выполняет сравнение 
«больше?». 

5. Соедините выход Peak to Peak экспресс-ВП Amplitude and Level Meas-
urements с входом Operand 1 экспресс-ВП Greater. 

6. Наведите курсор на проводник, который соединяет выход Peak to Peak 
со входом Operand 1. 

7. Когда появится инструмент Перемещение, щелкните правой кнопкой 
мыши по проводнику и выберите Create → Numeric Indicator (Создать → Чис-
ловой индикатор) из контекстного меню. 

 

Терминал Peak to Peak, который показан слева, появится на 
блок-диаграмме. Если терминал Peak to Peak появится на провод-
никах между экспресс-ВП, передвиньте экспресс-ВП и терминал 
Peak to Peak, создавая больше места. Например, переместите тер-
минал Peak to Peak на свободное место выше экспресс-ВП.  
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Предупреждение пользователя 
 
После задания значения, при котором светодиод будет загораться, необ-

ходимо соединить светодиодный индикатор с экспресс-ВП Greater. 
Выполните следующие шаги, чтобы создать визуальную индикацию, ко-

гда размах сигнала превысит заданный предел.  
1. На блок-диаграмме поместите терминал Warning (Предупреждение) 

справа от экспресс-ВП Greater. Удостоверьтесь, что этот терминал находится в 
цикле While, как показано на рисунке 1.20.  

 

 
 

Рисунок 1.20 – Блок-диаграмма ВП Warning Light 
 

2. Соедините выход Result (Результат) экспресс-ВП Greater с термина-
лом Warning. Блок-диаграмма должна выглядеть, как показано на рисунке 1.20. 

3. Переключитесь на лицевую панель. 
На ней появится числовой индикатор с ярлыком Peak to Peak. Этот инди-

катор отображает значение полной амплитуды сигнала. 
4. Запустите ВП.  
Когда значение двойной амплитуды превысит 2,0, индикатор Warning за-

горается. 
5. Нажмите кнопку STOP, чтобы остановить ВП. 
6. Сохраните ВП.  
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Настройка виртуального прибора для сохранения данных в файл 
 
Чтобы сохранить информацию о данных, которые моделирует ВП, ис-

пользуйте экспресс-ВП Write To Measurement File. 
Выполните следующие шаги для создания ВП, который сохраняет значе-

ния амплитуды размаха и другую информацию в файл данных LabVIEW.  
Найдите экспресс-ВП Write To Measurement File и поместите его на блок-

диаграмму ниже и правее экспресс-ВП Amplitude and Level Measurements.  
На экране появится диалоговое окно настройки Configure Write To 

Measurement File.  
Текстовое поле File Name содержит полный путь к выходному файлу 

test.lvm. 
Данные в файле lvm записывают в виде таблицы, состоящей из столбцов 

разделенных символом табуляции. Этот файл можно открыть с помощью при-
ложений для просмотра и редактирования электронных таблиц или текстовых 
файлов. Среда LabVIEW сохраняет данные с шестью разрядами точности. По 
умолчанию файл сохранится в папке LabVIEW Data. Среда LabVIEW располага-
ет папку LabVIEW Data в заданном по умолчанию каталоге файлов операцион-
ной системы.  

При необходимости просмотреть данные используйте путь к файлу, отоб-
раженный в текстовом поле File Name. 

2. В разделе If a file already exists (Если файл уже существует) диалого-
вого окна Configure Write To Measurement File выберите опцию Append to file, 
чтобы дописать все данные в файл test.lvm, не стирая уже существующие. 

3. В разделе Segment Headers (Заголовки сегмента) выберите опцию One 
header only, чтобы создать только один заголовок файла, в который LabVIEW 
записывает данные. 

4. В текстовое поле File Description введите следующий текст: Sample of 
peak to peak values (Пример значений размаха сигнала). LabVIEW прикрепит 
этот текст к заголовку файла.  

5. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть 
диалоговое окно Configure Write To Measurement File.  

 
Сохранение данных в файл  
 
После завершения работы ВП среда LabVIEW сохранит данные в файл 

test.lvm. Выполните следующие шаги, чтобы создать файл test.lvm. 
1. На блок-диаграмме соедините выход Peak to Peak экспресс-ВП 

Amplitude and Level Measurements с входом Signals (Сигналы) экспресс-ВП Write 
To Measurement File.  

2. Выберите File → Save (Файл → Сохранить как) и сохраните ВП как 
Save Data.vi в заранее определенном месте.  

3. Переключитесь на лицевую панель и запустите ВП. 
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4. Нажмите кнопку STOP на лицевой панели. 
5. Чтобы просмотреть данные, которые вы сохранили, откройте файл 

test.lvm в папке LabVIEW Data с помощью любого текстового редактора. Файл 
будет иметь заголовок, содержащий информацию об экспресс-ВП.  

6. Закройте файл после просмотра и вернитесь к ВП Save Data. 
 
Добавление кнопки сохранения данных в файл 
 
Для сохранения только определенных значений данных необходимо 

настроить экспресс-ВП Write To Measurement File так, чтобы значения ампли-
туды размаха сохранялись только тогда, когда пользователь нажимает кнопку. 

Выполните следующие шаги, чтобы добавить кнопку в ВП и настроить ее 
поведение при нажатии. 

1. Найдите в палитре элементов управления тумблер (rocker button) и по-
местите его справа от графиков. 

2. Щелкните правой кнопкой мыши по кнопке и выберите опцию 
Properties (Свойства) из контекстного меню, чтобы отобразить диалоговое ок-
но свойств. 

3. Измените метку кнопки на Write to File. 
4. На вкладке Operation (Функционирование) диалогового окна Boolean 

Properties выберите режим Latch when pressed из меню Button behavior (Режим 
работы). Это меню используется для задания поведения кнопки при нажатии. 
Увидеть, как кнопка реагирует на щелчок, можно в разделе Preview Selected 
Behavior.  

5. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть 
диалоговое окно Boolean Properties.  

6. Сохраните ВП.  
 
Сохранение данных по запросу пользователя  
 
Выполните следующие шаги, чтобы создать ВП, который регистрирует 

данные в файл, когда пользователь нажимает кнопку на лицевой панели. 
1. На блок-диаграмме дважды щелкните по экспресс-ВП Write To 

Measurement File, чтобы отобразить диалоговое окно Configure Write To Meas-
urement File.  

2. В текстовом поле File Name измените имя файла test.lvm на Selected 
Samples.lvm, чтобы сохранить данные в другой файл.  

3. Нажмите OK, чтобы сохранить текущую конфигурацию и закрыть диа-
логовое окно Configure Write To Measurement File. 

4. Щелкните правой кнопкой мыши по входу Signals экспресс-ВП Write 
To Measurement File и выберите пункт Insert Input/Output из контекстного меню, 
чтобы вставить вход Comment (Комментарий).  
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5. Щелкните правой кнопкой мыши по входу Comment экспресс-ВП Write 
To Measurement File и выберите Select Input/Output → Enable из контекстного ме-
ню, чтобы заменить вход Comment входом Enable. Входы и выходы экспресс-ВП 
появляются в таком же порядке, в котором вы их добавляете.  

Чтобы выбрать определенный вход, возможно, сначала придется создать 
произвольный, а затем изменить его на тот, который хотите использовать, щел-
кая по нему правой кнопкой мыши и выбирая подходящий из меню.  

6. Поместите терминал кнопки Write to File слева от экспресс-ВП Write To 
Measurement File.  

7. Соедините терминал Write to File с входом Enable экспресс-ВП Write To 
Measurement File.  

Блок-диаграмма должна выглядеть так, как показано на рисунке 1.21.  
 

 
 

Рисунок 1.21 – Блок-диаграмма ВП save data 
 

Просмотр сохраненных данных 
 
Выполните следующие шаги, чтобы просмотреть данные, которые вы со-

хранили в файл Selected Samples.lvm. 
1. Переключитесь на лицевую панель и запустите ВП. Нажмите кнопку 

Write to File несколько раз. 
2. Нажмите кнопку STOP на лицевой панели. 
3. Откройте файл Selected Samples.lvm с помощью текстового редактора. 
Файл Selected Samples.lvm отличается от файла test.lvm. 
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В test.lvm записались все данные, сгенерированные ВП Save Data, тогда 
как в файл Selected Samples.lvm данные записывались только тогда, когда вы 
нажимали кнопку Write to File. 

4. Закройте файл после просмотра.  
5. Сохраните и закройте ВП.  
В результате выполнения данного задания должен быть создан ВП, кото-

рый генерирует сигнал, фильтрует его, показывает, превышает ли сигнал опре-
деленный предел, и сохраняет данные. После завершения этого упражнения 
лицевая панель виртуального прибора должна соответствовать рисунку 1.22.  

 

 
 

Рисунок 1.22 – Лицевая панель ВП Save Data 
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1.4 Сбор данных и взаимодействие с приборами 
 
Включите персональный компьютер. Запустите программное обеспече-

ние LabVIEW. Для этого дважды щелкните левой клавишей мыши по значку 
LabVIEW на рабочем столе Windows или выберите в меню Пуск программу 
LabVIEW.  

В данной лабораторной работе будет использоваться экспресс-ВП DAQ 
Assistant (Помощник по сбору данных) для создания задачи DAQmx.  

DAQmx − это интерфейс программирования, который используется для 
взаимодействия с устройствами сбора данных. Для получения информации о 
других методах создания задач DAQmx обратитесь к разделу Getting Started → 
Getting Started with DAQ → Taking an NI-DAQmx Measurement in LabVIEW на 
вкладке Contents справки LabVIEW Help.  

В инструментальном драйвере DAQmx под задачей понимают набор из 
одного или более каналов, установленных временных характеристик, синхро-
низации и других свойств. В общем задача представляет собой выполняемую 
операцию по измерению или генерации сигнала. Например, вы можете создать 
задачу для измерения температуры в одном или более каналах устройства сбора 
данных. 

 
Создание DAQmx задачи 
 
Выполните следующие шаги, чтобы создать и настроить задачу, которая 

считывает уровень напряжения с помощью DAQ устройства. 
1 Откройте новый ВП. 
2 На блок-диаграмме в палитре функций выберите Express → Input, чтобы 

появилась подпалитра Input.  

 

3 В подпалитре Input выберите экспресс-ВП DAQ As-
sistant, показанный на рисунке слева, и поместите его на 
блок-диаграмму. После этого запустится помощник по сбо-
ру данных DAQ Assistant и на экране появится диалоговое 
окно Create New (Создать новый).  

4 Щелкните по Analog Input (Аналоговый ввод), чтобы отобразить опции 
ввода аналоговых сигналов.  

5 Выберите Voltage (Напряжение) для создания задачи по измерению 
напряжения в канале аналогового ввода.  

В диалоговом окне появится список каналов для каждого из установлен-
ных устройств сбора данных. Число каналов в списке зависит от количества ка-
налов, которое имеется в устройстве сбора данных.  

6 В списке Supported Physical Channels (Поддержка физического канала) 
выберите физический канал, в который поступает сигнал, например ai0, и затем 
нажмите кнопку Finish. Помощник по сбору данных откроет новое диалоговое 
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окно, показанное на рисунке 1.23, в котором отобразятся опции для настройки 
канала, который вы выбрали для выполнения задачи.  

7 В разделе Input Range на вкладке Settings введите 10 для максимального 
значения (Max) и минус 10 для минимального значения (Min). 

8 На вкладке Task Timing выберите опцию N Samples. 
9 В текстовое поле Samples To Read введите значение 1000.  
 

 
 

Рисунок 1.23 – Конфигурирование задачи с использованием помощника  
по сбору данных 

 
Тестирование задачи 
 
Для проверки правильности конфигурирования канала необходимо про-

тестировать задачу. 
Выполните следующие шаги, чтобы убедиться, что данные поступают на 

устройство сбора данных.  
1. Нажмите кнопку RUN. На экране появится диалоговое окно DAQ 

Assistant. 
2. Нажмите кнопку Start (Пуск) несколько раз, убедитесь, что данные по-

лучены, затем нажмите кнопку Close, чтобы вернуться к DAQ Assistant.  
3. Нажмите кнопку OK, чтобы сохранить текущую конфигурацию и за-

крыть DAQ Assistant. LabVIEW автоматически создаст ВП.  
4. Сохраните ВП как Read Voltage.vi в заранее определенном месте.  
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Отображение получаемых данных  
 
Выполните следующие шаги, чтобы построить на графике осциллограмм 

данные из канала и изменить название сигнала. 
1. На блок-диаграмме щелкните правой кнопкой мыши по выходу data 

(данные) и выберите опцию Create → Graph Indicator из контекстного меню. 
2. Переключитесь на лицевую панель и запустите ВП три или четыре ра-

за. Понаблюдайте за графиком диаграмм. На панели условных обозначений 
графика (plot legend), находящейся над графическим индикатором, появится 
слово Voltage.  

3. На блок-диаграмме щелкните правой кнопкой мыши по экспресс-ВП 
DAQ Assistant и выберите Properties (Свойства) из контекстного меню, чтобы 
открыть DAQ Assistant .  

4. Щелкните правой кнопкой мыши по пункту Voltage в списке каналов и 
выберите Rename (Переименовать) из контекстного меню, чтобы появилось 
диалоговое окно Rename a channel or channels. 

Примечание – Также для отображения диалогового окна Rename a 
channel or channels можно выбрать название канала и нажать клавишу <F2>.  

5. В текстовое поле New Name введите First Voltage Reading и нажмите 
кнопку OK. 

6. Нажмите кнопку OK, чтобы сохранить текущую конфигурацию и за-
крыть окно DAQ Assistant. 

7. Переключитесь на лицевую панель и запустите ВП. В условных обо-
значениях графика осциллограмм появится First Voltage Reading. 

8. Сохраните ВП.  
 
Редактирование задачи DAQmx 
 
Проведите редактирование задачи получения сигнала. Чтобы иметь воз-

можность сравнивать два разных значения напряжения, можно добавить в зада-
чу еще один канал. Кроме этого, можно настроить задачу таким образом, чтобы 
показания напряжения считывались непрерывно. 

Выполните следующие шаги, чтобы добавить новый канал к задаче и 
настроить непрерывное получение данных. 

1. На блок-диаграмме дважды щелкните по экспресс-ВП DAQ Assistant, 
чтобы открыть помощник по сбору данных DAQ Assistant. 

 

2. Нажмите кнопку Add Channels, которая показана 
на рисунке слева, и выберите канал Voltage (Напряже-
ние) из меню Add Channel, чтобы появилось диалоговое 
окно Add Channels To Task.  
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3. Выберите любой неиспользуемый физический канал из списка 
Supported Physical Channels и нажмите кнопку OK, чтобы вернуться в DAQ 
Assistant.  

4. Переименуйте канал в Second Voltage Reading.  
5. На вкладке Task Timing выберите опцию Continuous. Когда вы устанав-

ливаете опции временных характеристик и синхронизации в DAQ Assistant, эти 
опции применяются ко всем каналам из списка.  

6. Нажмите кнопку OK, чтобы сохранить текущую конфигурацию и за-
крыть DAQ Assistant. На экране появится диалоговое окно Confirm Auto Loop 
Creation. 

7. Нажмите кнопку Yes. LabVIEW автоматически разместит цикл While 
вокруг экспресс-ВП DAQ Assistant и графического индикатора. На блок-
диаграмме появится кнопка остановки, соединенная с входом stop экспресс-ВП 
DAQ Assistant.  

Выход stopped экспресс-ВП соединен с терминалом условия выхода из 
цикла. 

Блок-диаграмма должна выглядеть так, как показано на рисунке 1.24.  
 

 
Рисунок 1.24 – Блок-диаграмма ВП Read Voltage 

 
Если во время выполнения этого ВП происходит ошибка или вы нажима-

ете кнопку СТОП, экспресс-ВП DAQ Assistant останавливает чтение данных; 
выход stopped возвращает значение TRUE (Истина) и останавливает цикл 
While.  

 
Визуальное сравнение двух графиков напряжений 
 
Поскольку на графическом индикаторе изображены два графика напря-

жения, настройте их, чтобы они визуально различались.  
Для настройки цвета графика на индикаторе выполните следующие шаги.  
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1. На лицевой панели разверните панель настройки графиков, чтобы было 
видно название обоих графиков.  

2. Запустите ВП.  
На графике появятся две функции, а в панели настройки будут отобра-

жаться названия обеих кривых. 
3. Щелкните правой кнопкой мыши по First Voltage Reading в панели 

настройки графика и выберите пункт Color (Цвет) из контекстного меню. Ис-
пользуя инструмент копирования цвета, выберите цвет, например желтый, что-
бы график был хорошо виден. Измените цвет графика Second Voltage Reading.  

4. Остановите ВП.  
5. Сохраните ВП.  
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2 ЛАБОРАТОРНАЯ РАБОТА №А1.  
КОМПЬЮТЕРНО-ИЗМЕРИТЕЛЬНАЯ СИСТЕМА С ФУНКЦИЯМИ 
ГЕНЕРАТОРА СИГНАЛОВ ПРОИЗВОЛЬНОЙ ФОРМЫ 

 
2.1 Цель работы:  
 
– изучение структурной схемы и принципа действия компьютерно-

измерительной системы с функциями генератора сигналов произвольной формы;  
– изучение диалоговой структуры программного обеспечения компью-

терно-измерительной системы; 
– проведение измерений и протоколирование результатов измерений, по-

лученных с помощью компьютерно-измерительной системы;  
– оценка погрешности полученных результатов измерений.  
 
2.2 Основные теоретические положения 
 
Измерительный генератор – это источник измерительных сигналов с за-

ранее известными параметрами, предназначенный для исследования, настройки 
и проверки функционирования радиотехнических цепей и устройств. Парамет-
ры сигналов могут быть фиксированными и регулируемыми в определенных 
пределах. Именно возможность установки и регулировки параметров генериру-
емых сигналов с нормированной погрешностью отличает измерительные гене-
раторы (ИГ) от других источников сигналов. Однако этим не ограничивается 
область применения ИГ, которые являются одними из наиболее распространен-
ных радиоизмерительных приборов и широко применяются при измерениях 
электрических и неэлектрических величин.  

Простым примером может служить виртуальный генератор сигналов. Та-
кой виртуальный генератор имеет реальный электрический выход, реальные 
входы для обеспечения внутренней и внешней синхронизации, а также вирту-
альные ручки управления, которые по своему функциональному назначению 
аналогичны обычному генератору. Выходные электрические сигналы (гармо-
нический, пилообразный, прямоугольный, случайный и т. д.) формируются 
цифроаналоговым преобразователем (ЦАП). Генерация сигналов различной 
формы осуществляется программно-математическими методами. Например, ес-
ли для генерации синусоидального сигнала в реальном генераторе используется 
колебательный контур, включенный в цепь обратной связи усилителя, то в вир-
туальном генераторе гармонический сигнал получается математически непо-
средственно по соответствующей тригонометрической формуле для сигнала 
синусоидальной формы. Ясно, что в этом случае генерируется почти идеальный 
синусоидальный сигнал без нелинейных искажений с очень стабильной часто-
той и амплитудой, а также с известной начальной фазой. В реальном генераторе 
такие метрологические параметры практически недостижимы.  
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Виртуальные цифровые генераторы, получающие все более широкое рас-
пространение, удобнее аналоговых в эксплуатации: у них выше быстродей-
ствие, существенно проще установка требуемой частоты, более наглядная ин-
дикация. Кроме того, виртуальные цифровые генераторы имеют возможность 
автоматической перестройки частоты по заранее заданной программе и приме-
нения в сочетании с цифровыми средствами обработки информации.  

Принцип действия виртуальных цифровых генераторов основан на прин-
ципе формирования цифрового кода, описывающего форму заданного сигнала, 
с последующим преобразованием его в аналоговый сигнал с помощью цифро-
аналогового преобразователя (ЦАП).  

Самый простой вид аппроксимации – ступенчатая. Она заключается в 
представлении (замене) генерируемого колебания напряжением ступенчатой 
формы, достаточно мало отличающейся от формы генерируемого сигнала (ри-
сунок 2.1, а).  

 

 
а 

 
б 

а – ступенчатая аппроксимация;  
б – упрощенная структурная схема  

Рисунок 2.1 – Цифровой генератор низких частот  
 

Аппроксимируемое напряжение дискретизируется во времени (равномер-
ная дискретизация с шагом ∆t) и в интервале, разделяющем два соседних мо-
мента времени ti и ti+1, колебание заменяется напряжением постоянного тока –
ступенькой, высота которой U0 равна значению аппроксимируемого напряже-
ния в момент ti. В результате такой замены вместо линейно нарастающего 
напряжения получается ступенчатая линия, изображенная на рисунке 2.1, а.  

При имеющемся периоде Т формируемого сигнала линейной формы ко-
личество ступенек N, приходящихся на один период, определяется шагом дис-
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кретизации: N = Т/∆t. При заранее заданном количество ступенек изменение 
шага дискретизации приводит к изменению периода формируемого напряже-
ния, поскольку Т = N∆t.  

Уравнение ступенчатой линии можно представить в виде  
 

∑
=

==
n

i

i
iA UNUU

0
00 2a .                                          (2.1) 

 
Кроме того, ступенчатая линия тем точнее приближается по форме к пи-

лообразному напряжению (уменьшается погрешность аппроксимации), чем 
больше выбрано количество ступеней N. Когда это количество достаточно ве-
лико, сформированное пилообразное напряжение можно рассматривать как ли-
нейно изменяющееся напряжение, искаженное в небольшой степени высокоча-
стотной аддитивной помехой.  

Спектральный анализ напряжения, полученного путем ступенчатой ап-
проксимации, показывает, что его спектр содержит гармонику основной часто-
ты и ряд высших гармоник. При этом оказывается, что ближайшей к основной 
высшей гармоникой будет составляющая с номером N – 1, следующей – гармо-
ника с номером N + 1, затем гармоники с номерами 2N – 1 и 2N + 1 и т. д. 
Например, при N = 25 и частоте напряжения основной гармоники ближайшими 
высшими гармониками будут 24-я, 26-я и 49-я, 51-я гармоники, т. е. напряже-
ния частот – 24f, 26f, 49f, 51f. Такие соотношения между основной и высшими 
гармониками позволяют просто осуществить высококачественную фильтра-
цию, резко ослабляющую уровни высших гармоник, т. е. получить синусои-
дальное напряжение, характеризуемое достаточно малым коэффициентом не-
линейных искажений.  

Упрощенная структурная схема цифрового генератора, формирующего 
пилообразное напряжение, приведена на рисунке 2.1, б. Генератор импульсов 
вырабатывает периодическую последовательность импульсов с периодом сле-
дования Т. На выходе делителя частоты с регулируемым коэффициентом деле-
ния M получается периодическая последовательность импульсов с периодом 
следования ∆t = T/N, задающим шаг дискретизации сигнала во времени. Им-
пульсы поступают в четырехразрядный счетчик. Кодовая комбинация, опреде-
ляемая количеством импульсов, сосчитанных счетчиком, передастся в цифро-
аналоговый преобразователь, схема которого приведена на рисунке 2.2. По-
следний вырабатывает линейно ступенчатое напряжение, соответствующее ко-
личеству импульсов i. Таким образом, формируются N ступенек аппроксимиру-
емого пилообразного напряжения. После поступления на счетчик 16 импульсов 
счетчик переполняется и сбрасывается в нуль. С поступлением на счетчик 
(N + 1)-го импульса начинается формирование нового периода линейно ступен-
чатого напряжения. Частоту формируемого колебания при фиксированном чис-
ле ступенек N регулируют, изменяя шаг дискретизации ∆t, что достигается из-
менением коэффициента деления N делителя частоты.  
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Рисунок 2.2 – Схема цифроаналогового преобразователя 

 
Наряду с этим одним из основных параметров электрических колебаний, 

определяющих состояние колебательного процесса в любой заданный момент 
времени, является его начальная фаза. Наряду с начальной фазой одного коле-
бания интерес представляет соотношение начальных фаз двух колебаний. 
Необходимость в измерениях этих параметров возникает при исследовании 
усилителей, фильтров, линейных цепей, градуировке фазовращателей, снятии 
фазочастотных характеристик различных радиотехнических устройств и 
т. п. [1]. 

 
Структурная схема и принцип действия двухканального измерительного 

генератора с регулируемым фазовым сдвигом 
 

Представляемый двухканальный измерительный генератор с регулируе-
мым фазовым сдвигом позволяет генерировать гармонические (синусоидаль-
ные) сигналы, фиксируя фазовый сдвиг между ними.  

На рисунке 2.3 представлена структурная схема этого генератора. Пред-
ставленный генератор в своем составе имеет тактовый генератор, в котором 
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формируются импульсы с периодом следования ∆tх, регистр сдвига, предназна-
ченный для задержки последовательности импульсов, постоянные запоминаю-
щие устройства ПЗУ1 и ПЗУ2, в которых содержится заранее записанная ин-
формация об двоичных кодах синусоидального сигнала, цифроаналоговые пре-
образователи ЦАП1 и ЦАП2 и операционные усилители ОУ1 и ОУ2, усилива-
ющие сигнал на выходе ЦАП.  

 
Рисунок 2.3 – Структурная схема двухканального измерительного генератора 

с регулируемым фазовым сдвигом 
 

Принцип работы двухканального генератора поясняется временными 
диаграммами, приведенными на рисунке 2.4.  

 

 
Рисунок 2.4 – Принцип работы двухканального измерительного генератора  

с регулируемым фазовым сдвигом 
 

В тактовом генераторе формируется последовательность прямоугольных 
импульсов, которая на его выходе разделяется на два канала: первая последова-
тельность поступает на вход ПЗУ2, а вторая – на регистр сдвига, который фор-
мирует временную задержку между этими последовательностями. После про-

U1 

U2 

Вых 2 

 

Тактовый 
генератор 

 

ПЗУ 1 ЦАП 1 Регистр 
сдвига 

ПЗУ 2 ЦАП 2 

ОУ 1 

ОУ 2 

Вых 1 
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хождения регистра сдвига вторая последовательность поступает на ПЗУ1. Та-
ким образом, формируется фазовый сдвиг между двумя когерентными сигна-
лами.  

В ПЗУ1 и ПЗУ2 содержится заранее записанная информация об двоичных 
кодах синусоидального сигнала в моменты его временной дискретизации. С 
приходом каждого импульса тактового генератора цифровой код n-го отсчета 
подается на выход ПЗУ и делается сдвиг на следующий отсчет n + 1. С прихо-
дом следующего импульса отсчет n + 1 подается на выход и делается сдвиг 
на n + 2. Данный процесс повторяется циклически и определяется разрядностя-
ми ПЗУ и ЦАП.  

Сигнал с выходов ПЗУ1 и ПЗУ2 в цифровом виде поступает на входы 
ЦАП1 и ЦАП2, где преобразуется в аналоговое синусоидальное напряжение с 
последующим усилением с помощью ОУ1 и ОУ2.  

Рассмотрим процесс формирования гармонического сигнала.  
Известно, что гармонические сигналы (или синусоидальные), описывают-

ся следующими формулами:  
 

U(t) = UM ⋅ sin (ω0t + ϕ) = UM ⋅ sin (2πf0t + ϕ),                        (2.2) 
 

где UM, f0, ω0, ϕ – постоянные величины, которые могут исполнять роль инфор-
мационных параметров сигнала:  

UM – амплитуда сигнала,  
f0 – частота в герцах,  
ω0 = 2πf0 – угловая частота в радианах,  
ϕ – начальный фазовый угол в радианах.  
С учетом того, что период одного колебания T = 1/f0 = 2π/ω0 и T = nt, а 

t = T/n, формула (2.2) преобразовывается в  
 

U(t) = Um ⋅ sin (2πt/T) = Um ⋅ sin (2π/n).                            (2.3) 
 

Поскольку речь идет о дискретном сигнале, то каждая i-я импульсная по-
следовательность после ПЗУ будет иметь свою амплитуду, значение которой 
выражается следующим образом [2]:  

 
U(t)i = Um ⋅ sin (2πi/n).                                          (2.4) 

 
Предполагая, что ϕ = 0 и Um = 1 В, а период следования синусоидального 

сигнала Т = 2π разбит на 32 различных дискретных уровня q выходного сигнала 
(импульса), мы получили таблицу 2.1. В ней содержатся двоичные коды мгно-
венных значений синусоидаьного сигнала, которые записаны в ПЗУ, а также 
аналоговые значения напряжений, соответствующих этим двоичным кодам. В 
таблице 2.1 приведены также уравнения, описывающие мгновенные значения 
синусоидального сигнала.  
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Таблица 2.1 – Цифровые коды, записанные в ПЗУ  
 

Уравнение Значение  
напряжения, В Цифровой код 

U0 = Um sin 2π
32
⋅0 0,000 0000 0000 0000 0000 

U1 = Um sin 2π
32
⋅1 0,195 0000 0001 1001 0101 

U2 = Um sin 2π
32
⋅2 0,383 0000 0011 1000 0011 

U3 = Um sin 2π
32
⋅3 0,556 0000 0101 0101 0110 

U4 = Um sin 2π
32
⋅4 0,707 0000 0111 0000 0111 

U5 = Um sin 2π
32
⋅5 0,831 0000 1000 0011 0001 

U6 = Um sin 2π
32
⋅6 0,924 0000 1001 0010 0100 

U7 = Um sin 2π
32
⋅7 0,981 0000 1001 1000 0001 

U8 = Um sin 2π
32
⋅8 1,000 0001 0000 0000 0000 

U9 = Um sin 2π
32
⋅9 0,981 0000 1001 1000 0001 

U10 = Um sin 2π
32
⋅10 0,924 0000 1001 0010 0100 

U11 = Um sin 2π
32
⋅11 0,831 0000 1000 0011 0001 

U12 = Um sin 2π
32
⋅12 0,707 0000 0111 0000 0111 

U13 = Um sin 2π
32
⋅13 0,556 0000 0101 0101 0110 

U14 = Um sin 2π
32
⋅14 0,383 0000 0011 1000 0011 

U15 = Um sin 2π
32
⋅15 0,195 0000 0001 1001 0101 

U16 = Um sin 2π
32
⋅16 0,000 0000 0000 0000 0000 

U17 = Um sin 2π
32

 17 минус 0,195 0000 0001 1001 0101 

U18 = Um sin 2π
32
⋅18 минус 0,383 0000 0011 1000 0011 

U19 = Um sin 2π
32
⋅19 минус 0,556 0000 0101 0101 0110 

U20 = Um sin 2π
32
⋅20 минус 0,707 0000 0111 0000 0111 

U21 = Um sin 2π
32
⋅21 минус 0,831 0000 1000 0011 0001 

U22 = Um sin 2π
32
⋅22 минус 0,924 0000 1001 0010 0100 

U23 = Um sin 2π
32
⋅23 минус 0,981 0000 1001 1000 0001 

U24 = Um sin 2π
32
⋅24 минус 1,000 0001 0000 0000 0000 

U25 = Um sin 2π
32
⋅25 минус 0,981 0000 1001 1000 0001 

U26 = Um sin 2π
32
⋅26 минус 0,924 0000 1001 0010 0100 

U27 = Um sin 2π
32
⋅27 минус 0,831 0000 1000 0011 0001 

U28 = Um sin 2π
32
⋅28 минус 0,707 0000 0111 0000 0111 

U29 = Um sin 2π
32
⋅29 минус 0,556 0000 0101 0101 0110 
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Продолжение таблицы 2.1  
 

Уравнение Значение  
напряжения, В Цифровой код 

U30 = Um sin 2π
32
⋅30 минус 0,383 0000 0011 1000 0011 

U31 = Um sin 2π
32
⋅31 минус 0,195 0000 0001 1001 0101 

U32 = Um sin 2π
32
⋅32 0,000 0000 0000 0000 0000 

 
2.3 Приборы, используемые для выполнения работы 
 
1. Персональный компьютер с операционной системой Windows 2000/XP, 

Windows Vista x64/x86, Linux®, Mac OS X.  
2. Плата сбора данных NI-DAQmx – NI PCI-6251. 
3. Соединительный кабель.  
4. Коннекторный блок. 
5. Программное обеспечение LabVIEW.  
 
2.4 Описание лабораторной установки  
 
Лабораторная установка, используемая при выпонении лабораторной ра-

боты, представляет собой совокупность персонального компьютера со встроен-
ной в него печатной платой сбора данных NI-DAQmx со следующими характе-
ристиками: 

– 16 аналоговых входов на 16 бит;  
– тактовая частота дискретизации АЦП 1,25 MS/s;  
– 4 аналоговых выхода по 16 бит с разрешением 2,8 MS/s;  
– 7 программируемых входных диапазонов (от ±100 мВ до ±10 В) на канал;  
– 48 ТТЛ цифровых входных/выходных линий (10 MГц);  
– программное обеспечение LabVIEW, коннекторный блок CB-68LP и со-

единительный кабель SHC68-68-EPM.  
 
2.5 Подготовка к выполнению работы 
 
2.5.1 По рекомендуемой литературе детально изучите принцип действия 

компьютерно-измерительных систем, основные режимы их работы и методики 
выполнения измерений с их помощью параметров исследуемых сигналов и 
объектов.  

2.5.2 Изучите методики создания генераторов сигналов произвольной 
формы, регулировки их параметров и проведения измерений параметров ис-
следуемых устройств с их помощью с оценкой погрешностей полученных ре-
зультатов.  
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2.5.3 Сделайте заготовку отчета по лабораторной работе (один на брига-
ду) в соответствии с требованиями настоящего учебно-методического пособия 
и объемом лабораторного задания.  

2.5.4 Ответьте на контрольные вопросы.  
2.5.5 Решите задачу.  
Определите форму сигнала, период повторения и пиковое значение 

напряжения выходного сигнала генератора, структурная схема которого приве-
дена на рисунке 2.5. Частота повторения импульсов, генерируемых генератором 
импульсов, равна 1 МГц. Коэффициент деления делителя частоты равен 10. 
Счетчик – восьмиразрядный. ЦАП – восьмиразрядный. Определите также 
младший разряд счета и погрешность задания значений выходного сигнала по 
частоте и напряжению.  

 

 
 

Рисунок 2.5 – Структурная схема генератора сигналов 
 

Решение задачи приведите в заговке отчета по лабораторной работе.  
 

2.6 Задание к лабораторной работе 
 

2.6.1 Создайте компьютерно-измерительную систему с функциями гене-
ратора сигналов произвольной формы.  

2.6.2 Проведите добавление нового элемента управления на лицевую па-
нель системы и измените вид генерируемого сигнала.  

2.6.3 Проведите измерение амплитудных, частотных и фазовых парамет-
ров генерируемого сигнала.  

2.6.4 Проведите оценку погрешности измерения заданных в пункте 2.6.3 
параметров генерируемого сигнала.  

 
2.7 Порядок выполнения работы 
 
2.7.1 Выполните работу в соответствии с пунктом 2.6.1 лабораторного за-

дания. Работу рекомендуется проводить в следующей последовательности.  
Включите персональный компьютер. Запустите программное обеспече-

ние LabVIEW. Создайте компьютерно-измерительную систему с функциями ге-
нератора сигналов произвольной формы, лицевая панель которой представлена 
на рисунке 2.6, а блок-диаграмма – на рисунке 2.7.  

Запустите компьютерно-измерительную систему путем нажатия кнопки 
Run (Пуск) на панели инструментов интерфейса. Также можно нажать комби-
нацию клавиш <Ctrl-R>. В случае возникновения затруднений воспользуйтесь 
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сведениями, приведенными в разделе 1 настоящего учебно-методического  
пособия.  

 

 
 

Рисунок 2.6 – Лицевая панель компьютерно-измерительной системы  
с функциями генератора сигналов произвольной формы 

 
Установите с помощью элементов управления «Амплитуда», «Частота» и 

«Начальная фаза», расположенных слева от графического индикатора, парамет-
ры генерируемого сигнала, заданные в соответствии с вариантом выполнения 
лабораторной работы в таблице 2.2.  

 
Таблица 2.2 – Варианты задания значений параметров генерируемого сигнала  

Номер варианта 1 2 3 4 5 6 7 8 9 10 
Амплитуда, В 1 2 3 4 5 6 7 8 9 10 
Частота, Гц 10 20 30 40 50 60 70 80 90 100 
Фазовый сдвиг, 
град  

 
15 

 
25 

 
43 

 
56 

 
77 

 
89 

 
120 

 
180 

 
90 

 
270 

 
Пронаблюдайте на экране осциллографического индикатора изображения 

генерируемых сигналов. Скопируйте наблюдаемые сигналы в память компьютера.  
Остановите генерацию исследуемого сигнала, нажав кнопку «Стоп» на 

лицевой панели ВП.  
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Рисунок 2.7 – Блок-диаграмма компьютерно-измерительной системы  

с функциями генератора сигналов произвольной формы 
 

2.7.2 Проведите добавление нового элемента управления на лицевую па-
нель системы и измените вид генерируемого сигнала.  

Откройте экспресс-ВП Formula. Измените масштабный множитель «*0,5» 
на «*π». Сохраните текущие настройки и закройте диалоговое окно Configure 
Formula.  

Запустите компьютерно-измерительную систему путем нажатия кнопки 
Run (Пуск) на панели инструментов интерфейса. Также можно нажать комби-
нацию клавиш <Ctrl-R>.  

Наблюдайте на экране осциллографического индикатора изображения гене-
рируемых сигналов. Скопируйте наблюдаемые сигналы в память компьютера.  

Остановите генерацию исследуемого сигнала, нажав кнопку «Стоп» на 
лицевой панели ВП.  

Измените вид генерируемого сигнала с синусоидального на пилообразный.  
Запустите компьютерно-измерительную систему путем нажатия кнопки 

Run (Пуск) на панели инструментов интерфейса. Также можно нажать комби-
нацию клавиш <Ctrl-R>. 

Наблюдайте на экране осциллографического индикатора изображения гене-
рируемых сигналов. Скопируйте наблюдаемые сигналы в память компьютера.  

Остановите генерацию исследуемого сигнала, нажав кнопку «Стоп» на 
лицевой панели ВП.  
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2.7.3 Проведите измерение амплитудных, частотных и фазовых парамет-
ров генерируемого сигнала.  

Проведите измерение заданных параметров генерируемого сигнала с по-
мощью вертикально-горизонтального маркера. Результаты измерений занесите 
в таблицу 2.3.  

 
Таблица 2.3 – Результаты измерений параметров генерируемого сигнала 

Наименование  
параметра 

Заданное 
значение 

Измеренное  
значение 

Погрешность  
измерения 

Амплитуда, В    
Частота, Гц    
Фазовый сдвиг, град    

 
2.7.4 Проведите оценку погрешности измерения заданных в пункте 2.6.3 

параметров генерируемого сигнала.  
Определите погрешность измерения амплитуды, частоты и начальной фа-

зы сигнала. Результаты расчетов занесите в таблицу 2.3.  
 

2.8 Содержание отчета 
 

2.8.1 Отчет по лабораторной работе должен содержать: титульный лист с 
указанием фамилии студента, номера группы и номера варианта выполняемого 
лабораторного задания, формулировку цели лабораторной работы, перечень за-
даний к выполнению лабораторной работы, перечень применяемого при вы-
полнении работы оборудования.  

2.8.2 В отчете необходимо привести структурную схему компьютерно-
измерительной системы и ее блок-диаграмму, а также осциллограммы полу-
ченных в результате выполнения работы сигналов измерительной информации.  

2.8.3 Результаты измерений параметров сигналов (амплитуда, частота, фа-
зовый сдвиг), полученных в результате выполнения работы, следует приводить 
в виде таблиц с оценкой погрешности измерения.  
 

2.9 Контрольные вопросы  
 
1. Дайте определение компьютерно-измерительной системе. Какие функ-

ции она способна выполнять?  
2. Как происходит генерация исследуемого сигнала с использованием 

цифроаналоговых преобразователей?  
3. Как осуществляется регулировка амплитуды генерируемого колебания 

в цифровых генераторах?  
4. Как осуществляется регулировка частоты генерируемого колебания в 

цифровых генераторах?  
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5. Как осуществляется регулировка фазовых сдвигов генерируемого си-
нусоидального колебания в цифровых генераторах?  

 
Литература 

 
1. Евдокимов, Ю. К. LabVIEW для радиоинженера: от виртуальной модели 

до реального прибора / Ю. К. Евдокимов, В. Р. Линдваль, Г. И. Щербаков. –  
М. : ДМК Пресс, 2007. – 400 с.  

2. Пейч, Л. И. LabVIEW для новичков и специалистов / Л. И. Пейч,  
Д. А. Точилин, Б. П. Поллак. – М. : Горячая линия – Телеком, 2004. – 384 с.  

3. Суранов, А. Я. LabVIEW 8.20: справочник по функциям / А. Я. Суранов. – 
М. : ДМК Пресс, 2007. – 536 с.  
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3 ЛАБОРАТОРНАЯ РАБОТА №А2.  
КОМПЬЮТЕРНО-ИЗМЕРИТЕЛЬНАЯ СИСТЕМА С ФУНКЦИЯМИ 
ДВУХКАНАЛЬНОГО ОСЦИЛЛОГРАФА 

 
 
3.1 Цель работы: 
 
– изучение структурной схемы, блок-диаграммы и принципа действия 

компьютерно-измерительной системы с функциями двухканального электрон-
ного осциллографа, созданного на базе персонального компьютера; 

– изучение диалоговой структуры программного обеспечения компью-
терно-измерительной системы; 

– проведение измерений и протоколирование результатов, полученных с 
помощью компьютерно-измерительной системы; 

– оценка точности полученных результатов измерений. 
 
3.2 Основные теоретические положения 
 
Знание амплитудных, частотных и фазовых параметров в ряде случаев 

оказывается недостаточным для решения практических задач. Поэтому акту-
альной задачей измерений является также исследование формы, спектра и не-
линейных искажений сигналов. При этом под исследованием понимается обес-
печение возможности визуального наблюдения сигналов и измерения их пара-
метров.  

Исследование сигналов, отличающихся большим разнообразием форм, 
может осуществляться во временной и частотной (спектральной) областях.  

Задачей временного анализа является качественное и количественное ис-
следование зависимости сигнала от времени. 

Спектральный анализ позволяет исследовать спектры сигналов, т. е. 
определять амплитуды и частоты гармонических составляющих сигнала. Кроме 
того, применение различных видов модуляции выдвигает задачу измерения па-
раметров модулированных колебаний.  

На рисунке 3.1 в упрощенном виде показана структурная схема цифрово-
го осциллографа. Входное устройство представляет собой в простейшем случае 
делитель (аттенюатор) или усилитель измеряемого напряжения, с помощью ко-
торых расширяется динамический диапазон входных сигналов осциллографа. 
Помимо точного деления или усиления входного напряжения входное устрой-
ство не должно снижать входной импеданс осциллографа, влияющий на мето-
дическую погрешность измерения u(t).  

Основным функциональным узлом цифрового осциллографа является 
аналого-цифровой преобразователь (АЦП), который преобразует измеряемую 
непрерывную (аналоговую) величину в цифровой код – выходной сигнал АЦП. 
Процесс преобразования включает в себя следующие основные этапы: дискре-
тизацию измеряемой величины во времени, квантование ее по уровню и цифро-
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вое кодирование. В состав аналого-цифрового преобразователя входит опера-
тивное запоминающее устройство, служащее для записи цифровых кодов с вы-
хода АЦП.  

Шаг дискретизации определяется периодом повторения импульсов, выра-
батываемых генератором импульсов, который обеспечивает тактирование 
АЦП. Одновременно выходной сигнал генератора импульсов поступает на дво-
ичный счетчик, где происходит преобразование количества поступивших на 
счетчик импульсов в цифровой код. Выходной цифровой код счетчика после 
преобразования в позиционные коды столбцов в дешифраторе столбцов посту-
пает на жидкокристаллический (ЖК) индикатор и обеспечивает «развертку» 
исследуемого сигнала в горизонтальной плоскости.  

Исследуемый сигнал u(t) поступает на входное устройство. Пройдя через 
входное устройство (усилитель и делитель напряжения), входной сигнал преоб-
разуется АЦП в дискретную последовательность кодовых слов Ni, отображаю-
щих мгновенные значения ui входного сигнала. Каждое новое кодовое слово за-
писывается в ОЗУ.  

 

 
Рисунок 3.1 – Упрощенная структурная схема цифрового осциллографа  

 
При этом все предыдущие записанные отсчеты сдвигаются на одну ячей-

ку (регистр сдвига), а самый первый N1 исчезает, как бы «выталкивается» из 
ОЗУ. Если ОЗУ состоит из М ячеек, то в нем постоянно обновляясь содержится 
М последних, «свежих», кодовых слов. Так продолжается до тех пор, пока не 
будет выполнено некое заданное условие, например, когда какое-либо ui впер-
вые превысит заданный оператором уровень («запуск по уровню»).  

После этого содержимое некоторого количества ячеек ОЗУ поступает в 
контроллер, который обеспечивает выдачу цифрового кода, соответствующего 
амплитуде сигнала в данный момент времени на дешифратор строк. В дешиф-
раторе строк происходит преобразование цифрового кода АЦП в позиционные 
коды строк ЖК-индикатора в соответствии с цифровым кодом счетчика им-
пульсов. Таким образом, происходит синхронизация позиционных кодов 
столбцов с позиционными кодами строк. Каждому позиционному коду строки и 
позиционному коду столбца соответствует точка на экране ЖК-индикатора, по 
цвету отличающаяся от фона. Другими словами, абсциссу точки на экране  
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ЖК-индикатора определяет номер ячейки ОЗУ, а ординату – кодовое слово Ni, 
находящееся в этой же ячейке. 

Для хорошего изображения сигнала на экране вполне достаточно двух 
точек на 1 мм. Если, для примера, рассмотреть экран средних размеров высотой 
100 мм и шириной 120 мм, то на нем должны располагаться 200 × 240 = 48 000 
точек или более.  

Таким образом, для формирования хорошего изображения АЦП должен 
иметь не менее восьми двоичных разрядов (256 точек по вертикали) и счетчик 
тоже должен быть восьмиразрядным, т. е. содержать на выходе 256 кодовых 
слов.  

Но количество ячеек ОЗУ может быть гораздо больше. Зачем?  
Цифровой осциллограф позволяет делать замечательную вещь – запоми-

нать в ОЗУ очень много кодовых слов, а потом «вытягивать» их порциями, со-
ответствующими ширине экрана. В аналоговых осциллографах это, конечно, 
невозможно. Для обозначения запаса по оси времени («глубина памяти») ино-
гда пользуются такой оценкой длительности сигнала, данные о котором запи-
саны в ОЗУ: «число экранов».  

Например, «8 экранов» означает, что объем памяти ОЗУ не 256, а 2048 
ячеек, в которых записано 2048 кодовых слов Ni. Каждое Ni – это восьмираз-
рядный код, т. е. один байт («8 экранов») – это объем памяти в 2 килобайта. 
Можно вообразить очень широкую экран-ленту – в восемь раз шире натураль-
ной, но такой же высоты. На такой ленте было бы записано изображение всего 
сигнала. Длина этой ленты будет достигать одного метра.  

Еще одно принципиальное отличие от аналоговых осциллографов состо-
ит в том, что в цифровом осциллографе можно видеть предысторию сигнала до 
появления импульса запуска. Это называют «предзапуском». Кодовые слова 
переписываются из ОЗУ в контроллер так, что в момент появления импульса 
запуска первой ячейкой запоминающего устройства контроллера будет та, что 
дает точку на вертикальной линии, проходящей через центр экрана, последую-
щие точки располагаются справа от нее, предыдущие – слева. Положение пер-
вой ячейки можно смещать влево или вправо от центра и тем самым соответ-
ственно уменьшать или увеличивать видимый интервал предыстории.  

Частоту дискретизации (частоту «выборок») можно изменять в широких 
пределах, изменяя период следования тактовых импульсов, т. е. изменяя часто-
ту выходного сигнала генератора импульсов. Это соответствует изменению 
масштаба по горизонтали и аналогично изменению скорости развертки в анало-
говых осциллографах.  

Для изменения масштаба по вертикали, как и в аналоговых осциллогра-
фах, можно изменять коэффициенты усиления или деления соответственно 
входного усилителя или делителя напряжения.  

В целом цифровые осциллографы имеют больше сходства с компьюте-
ром, чем с аналоговым осциллографом. Они позволяют выполнять различные 
математические операции: растягивать во времени фрагменты записанного в 
память сигнала, складывать и вычитать сигналы в разных каналах, определять 
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частотный спектр сигнала путем применения быстрого преобразования 
Фурье и т. д.  

 
3.3 Приборы, используемые для выполнения работы 
 
1. Персональный компьютер с операционной системой Windows 2000/XP, 

Windows Vista x64/x86, Linux®, Mac OS X.  
2. Плата сбора данных NI-DAQmx – NI PCI-6251. 
3. Соединительный кабель.  
4. Коннекторный блок. 
5. Программное обеспечение LabVIEW.  
 
3.4 Описание лабораторной установки  
 
Лабораторная установка, используемая при выполнении лабораторной 

работы, представляет собой совокупность персонального компьютера со встро-
енной в него печатной платой сбора данных NI-DAQmx со следующими харак-
теристиками:  

– 16 аналоговых входов на 16 бит;  
– тактовая частота дискретизации АЦП 1,25 MS/s;  
– 4 аналоговых выхода по 16 бит с разрешением 2,8 MS/s;  
– 7 программируемых входных диапазонов (от ±100 мВ до ±10 В) на канал;  
– 48 ТТЛ цифровых входных/выходных линий (10 MГц); 
– программное обеспечение LabVIEW, коннекторный блок CB-68LP и со-

единительный кабель SHC68-68-EPM.  
 
3.5 Подготовка к выполнению работы 
 
3.5.1 По рекомендуемой литературе детально изучите принцип действия 

компьютерно-измерительных систем, основные режимы их работы и методики 
выполнения измерений с их помощью параметров исследуемых сигналов и 
объектов.  

3.5.2 Изучите методики создания электронных осциллографов, регули-
ровки их параметров и проведения измерений параметров исследуемых сигна-
лов с их помощью с оценкой погрешностей полученных результатов.  

3.5.3 Сделайте заготовку отчета по лабораторной работе в соответствии с 
требованиями подраздела 3.8 настоящего учебно-методического пособия и объ-
емом лабораторного задания.  

3.5.4 Ответьте на контрольные вопросы.  
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3.6 Задание к лабораторной работе 
 

3.6.1 Создайте компьютерно-измерительную систему с функциями двух-
канального цифрового осциллографа.  

3.6.2 Измените вид генерируемого сигнала.  
3.6.3 Проведите измерение амплитудных, частотных и фазовых парамет-

ров исследуемого сигнала с помощью компьютерно-измерительной системы с 
функциями двухканального осциллографа.  

3.6.4 Проведите оценку погрешности измерения заданных в пункте 3.6.3 
параметров генерируемого сигнала.  

 
3.7 Порядок выполнения работы 
 
3.7.1 Выполните работу в соответствии с пунктом 3.6.1 лабораторного за-

дания. Работу рекомендуется проводить в следующей последовательности.  
Включите персональный компьютер. Запустите программное обеспече-

ние LabVIEW. Создайте компьютерно-измерительную систему с функциями 
двухканального цифрового осциллографа, лицевая панель которой представле-
на на рисунке 3.2, а блок-диаграмма – на рисунке 3.3.  

 

 
 

Рисунок 3.2 – Лицевая панель компьютерно-измерительной системы  
с функциями двухканального цифрового осциллографа  

 
Запустите компьютерно-измерительную систему путем нажатия кнопки 

Run (Пуск) на панели инструментов интерфейса. Также можно нажать комби-
нацию клавиш <Ctrl-R>. В случае возникновения затруднений воспользуйтесь 
сведениями, приведенными в разделе 1 настоящего учебно-методического по-
собия.  
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Рисунок 3.3 – Блок-диаграмма компьютерно-измерительной системы  

с функциями двухканального цифрового осциллографа  
 

Установите значения выходных параметров первого (верхнего) источника 
сигнала с помощью элементов управления «Амплитуда», «Частота» и «Началь-
ная фаза». Числовые значения параметров сигнала заданы в соответствии с ва-
риантом выполнения лабораторной работы в таблице 3.1.  

 
Таблица 3.1 – Варианты задания значений исследуемого сигнала  

Наименование пара-
метра 

Номер варианта 
1 2 3 4 5 6 7 8 9 10 

Амплитуда, В 1 2 3 4 5 6 7 8 9 10 
Частота, Гц 10 20 30 40 50 60 70 80 90 100 
Начальная фаза, град  15 25 43 56 77 89 120 180 90 270 
Амплитуда 2, В  1 2 3 4 5 6 7 8 9 10 
Частота 2, Гц 10 20 30 40 50 60 70 80 90 100 
Начальная фаза 2, град  270 90 180 120 89 77 56 43 25 15 
 

Установите значения выходных параметров второго (нижнего) источника 
сигнала с помощью элементов управления «Амплитуда 2», «Частота 2» и 
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«Начальная фаза 2». Числовые значения параметров сигнала заданы в соответ-
ствии с вариантом выполнения лабораторной работы в таблице 3.1.  

Пронаблюдайте на экране осциллографического индикатора одновремен-
ное изображение двух генерируемых сигналов. Скопируйте наблюдаемые сиг-
налы в память компьютера.  

Остановите генерацию исследуемого сигнала, нажав кнопку «Стоп» на 
лицевой панели ВП.  

3.7.2 Выполните работу в соответствии с пунктом 3.6.2 лабораторного за-
дания. Работу рекомендуется проводить в следующей последовательности.  

Измените вид генерируемого сигнала.  
На одном из виртуальных приборов экспресс-ВП измените вид генериру-

емого сигнала с синусоидального на треугольный.  
Запустите компьютерно-измерительную систему путем нажатия кнопки 

Run (Пуск) на панели инструментов интерфейса. Также можно нажать комби-
нацию клавиш <Ctrl-R>. 

Пронаблюдайте на экране осциллографического индикатора одновремен-
ное изображение двух различных генерируемых сигналов. Скопируйте наблю-
даемые сигналы в память компьютера. 

Остановите генерацию исследуемого сигнала, нажав кнопку «Стоп» на 
лицевой панели ВП.  

3.7.3 Выполните работу в соответствии с пунктом 3.6.3 лабораторного за-
дания. Работу рекомендуется проводить в следующей последовательности.  

Проведите измерение заданных параметров наблюдаемых на экране ис-
следуемых сигналов с помощью вертикально-горизонтального маркера цифро-
вого осциллографа. Результаты измерений занесите в таблицу 3.2.  

3.7.4 Выполните работу в соответствии с пунктом 3.6.4 лабораторного за-
дания. Работу рекомендуется проводить в следующей последовательности.  

Определите погрешность измерения амплитуды, частоты и начальной фа-
зы сигнала. Результаты расчетов занесите в таблицу 3.2.  

 
Таблица 3.2 – Результаты измерений параметров исследуемых сигналов 

Наименование  
параметра 

Заданное 
значение 

Измеренное  
значение 

Погрешность  
измерения 

Амплитуда, В    
Частота, Гц    
Амплитуда 2, В    
Частота 2, Гц    
Фазовый сдвиг, град    
 

3.8 Содержание отчета 
 
3.8.1 Отчет по лабораторной работе должен содержать: титульный лист с 

указанием фамилии студента, номера группы и номера варианта выполняемого 

Би
бл
ио
те
ка

 БГ
УИ
Р



 66 

лабораторного задания, формулировку цели лабораторной работы, перечень за-
даний к выполнению лабораторной работы, перечень применяемого при вы-
полнении работы оборудования.  

3.8.2 В отчете необходимо привести структурную схему компьютерно-
измерительной системы и ее блок-диаграмму, а также осциллограммы полу-
ченных в результате выполнения работы сигналов измерительной информации.  

3.8.3 Результаты измерений параметров сигналов (амплитуда, частота, фа-
зовый сдвиг), полученных в результате выполнения работы, следует приводить 
в виде таблиц с оценкой погрешности измерения.  
 

2.9 Контрольные вопросы  
 
1. Дайте определение компьютерно-измерительной системе. Какие функ-

ции она способна выполнять? 
2. Опишите принцип работы цифрового осциллографа (ЦО). 
3. Какие основные узлы и блоки входят в состав цифрового осцилло-

графа? Какова его структурная схема? 
4. Какие виды разверток используются в ЦО? Каково назначение и 

принцип действия этих разверток?  
5. Что такое синхронизация в цифровом осциллографе? Ее назначение 

в ЦО? 
6. Какие виды синхронизации используются в ЦО? Каковы условия 

синхронизации? 
7. Каким образом в двухканальном осциллографе обеспечивается воз-

можность наблюдения двух сигналов?  
8. Какими параметрами напряжения развертки определяется масштаб 

изображения по горизонтали при различных видах развертки?  
9. Какова методика измерения амплитудных параметров с помо-

щью ЦО?  
10. Какова методика измерения сдвига фаз с помощью ЦО?  
11. Каковы источники погрешности измерения с помощью ЦО?  
12. Как выбирать размеры изображения на экране ЭЛТ для обеспече-

ния минимальных погрешностей измерения?  
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4 ЛАБОРАТОРНАЯ РАБОТА №А3.  
КОМПЬЮТЕРНО-ИЗМЕРИТЕЛЬНАЯ СИСТЕМА С ФУНКЦИЯМИ 
ЧАСТОТОМЕРА И ИЗМЕРИТЕЛЯ ВРЕМЕННЫХ ИНТЕРВАЛОВ  

 
4.1 Цель работы:  
 
– изучение цифровых методов измерения частоты и периода электриче-

ских сигналов; 
– изучение компьютерно-измерительной системы с функциями частото-

мера и измерителя временных интервалов и приобретение практических навы-
ков работы с ней; 

– создание виртуального прибора для измерения частоты и периода ис-
следуемых сигналов и проведение измерения заданных в лабораторном задании 
параметров сигналов.  

 
4.2 Основные теоретические положения 
 
Основными частотно-временными параметрами электрических сигналов 

являются период Т, частота f, длительность импульса τ и скважность.  
Период – наименьший интервал времени, через который повторяются 

мгновенные значения сигнала U(t) = U(t + T) для любого произвольного момен-
та времени t. 

Частота – определяется как число идентичных событий (например мгно-
венных значений сигнала) в единицу времени, т. е. это величина, обратная пе-
риоду f = 1/Т (рисунок 4.1).  

Длительность импульса – интервал времени, в течение которого мгно-
венные значения импульсного сигнала не превышают уровень 0,5 от амплитуд-
ного значения.  

Кроме перечисленных параметров, импульсные сигналы иногда характе-
ризуются скважностью, которая определяется отношением Q = T/τ, где τ – 
длительность импульса.  

 

 
Рисунок 4.1 – Временная диаграмма для определения длительности  

импульса и скважности сигналов 
 

Приборы для измерения частоты и времени образуют подгруппу Ч, а для 
измерения только интервалов времени – подгруппу И. Достаточно подробная 

Би
бл
ио
те
ка

 БГ
УИ
Р



 68 

классификация методов измерения частоты и времени приведена, например 
в [1, 2 и др.]. В рамках данной работы изучается наиболее распространенный 
метод измерения частоты и периода – метод преобразования в цифровой код. 
Приборы, реализующие этот метод (вид Ч3), имеют весьма высокую точность и 
при этом компактны, надежны, технологичны и просты в управлении. Благодаря 
тому что при измерении различных частотно-временных параметров этим мето-
дом требуются однотипные электронные блоки, приборы Ч3 универсальны и 
обычно позволяют измерять несколько величин. Цифровые частотомеры имеют, 
как правило, довольно широкий диапазон частот входных сигналов. Их частот-
ный диапазон «вверх» ограничен лишь быстродействием элементной базы.  

Принцип действия цифрового частотомера основан на преобразовании 
частоты входного сигнала в цифровой код. Структурная схема частотомера, ре-
ализующая этот принцип, приведена на рисунке 4.2, а временные диаграммы, 
поясняющие ее работу, – на рисунке 4.3.  
 

 
Рисунок 4.2 – Структурная схема цифрового частотомера  

в режиме измерения частоты  
 

Сигнал U(t), частоту которого необходимо измерить, подается через 
входное устройство на формирующее устройство, где преобразуется в короткие 
импульсы (временная диаграмма U1, см. рисунок 4.3) с той же частотой. Ам-
плитуда этих импульсов не зависит от амплитуды и формы входного сигнала.  

Сигнал с периодом, равным единице времени и соответствующим време-
ни измерения ТИ (временная диагармма U2), формируется устройством управ-
ления из высокостабильного сигнала кварцевого генератора с помощью второго 
формирующего устройства и делителя частоты. В связи с тем что время изме-
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рения ТИ является мерой времени, от его точности и стабильности будет зави-
сеть точность измерений.  

 

 
Рисунок 4.3 – Временные диаграммы, поясняющие принцип измерения частоты  

 
Устройство управления формирует из сигнала кварцевого генератора им-

пульс длительностью ТИ (эпюра U3), который подается на первый вход логиче-
ской схемы И, которая представляет собой электронный ключ, при открывании 
которого на счетчик поступают импульсы с выхода первого формирующего 
устройства (временная диаграмма U4 на рисунке 4.3). Поскольку перед началом 
измерения счетчик обнуляется путем подачи импульса «Сброс» с выхода 
устройства управления, то по окончании интервала ТИ на него поступит N им-
пульсов: 

 

X
Х

f fТ
Т
TN ⋅== И

И .                                            (4.1) 

 
Следовательно, количество импульсов Nf, сосчитанных счетчиком, будет 

прямо пропорционально частоте сигнала fX, поданного на вход частотомера. 
Например, при ТИ = 1 с и Nf = 10 (как показано на рисунке 4.3) будет соответ-
ствовать частоте 10 Гц. Состояние счетчика индицируется в десятичной форме 
с помощью знакового индикатора. Емкость счетчика ограничивает максималь-
но измеряемое значение частоты, т. е. определяет предел измерения. Изменить 
его можно изменением времени измерения в пределах ТИ = 10m с, где m = 2, 1, 0, 
–1, –2, ... . При этом правильный отсчет обеспечится путем переноса десятич-
ной точки на знаковом индикаторе, что эквивалентно умножению или делению 
на 10. Схемотехнически это реализуется изменением коэффициента деления 
частоты с помощью делителя частоты.  
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Источниками погрешности являются нестабильность частоты выходного 
сигнала кварцевого генератора и погрешность дискретности. Погрешность дис-
кретности обусловлена тем, что счетчик считает лишь целое число импульсов, 
и поэтому равенство (3.1) справедливо с точностью до целого. Максимальная 
абсолютная погрешность при этом не превышает одного импульса. Относи-
тельная – 1/N. Результирующая относительная погрешность  

 









+δ±=










+δ±=δ

Xf
f fТN И

00
11 ,    (4.2) 

 
где δ0 – относительная нестабильность частоты кварцевого генератора.  

Как следует из формулы (4.2), с увеличением частоты измеряемого сиг-
нала fX погрешность дискретности при постоянном времени измерения умень-
шается, поэтому при измерениях высоких частот преобладает первая составля-
ющая погрешности, а при низких – вторая. Кроме того, видно, что одним из 
способов уменьшения погрешности измерения низких и инфранизких часто яв-
ляется увеличение времени измерения ТИ. Однако, если время измерения 
ТИ будет больше одной секунды, то оператор вынужден будет длительное вре-
мя ожидать индикацию результата измерения, что создает определенное не-
удобство в работе. К другим способам уменьшения погрешности дискретности 
относятся умножение частоты входного сигнала и применение электронного 
нониуса (верньерный способ). Первый из этих способов технически трудно ре-
ализуем на низких частотах, а второй широко используется разработчиками ча-
стотомеров. Наиболее часто на практике используют переход от измерения ча-
стоты к измерению периода.  

Действительно, из формулы (4.1) видно, что количество импульсов, по-
ступивших на счетчик, прямо пропорционально времени открывания логиче-
ской схемы «И». Поэтому, открывая логическую схему «И» на время измеряе-
мого периода ТХ и используя для счета импульсы известной частоты f0, получим 
количество импульсов N, соответствующее неизвестному периоду. Этот алго-
ритм реализуется структурной схемой, показанной на рисунке 4.4, а ее работа 
поясняется временными диаграммами (рисунок 4.5).  

Входной сигнал U(t) с периодом ТX (эпюра U1) поступает на входное 
устройство и преобразуется в формирующем устройстве в импульсы с тем же 
периодом повторения (эпюра U2) и поступает на делитель частоты с коэффици-
ентом деления 10n (n = 0, 1, 2,...), который выбирается оператором (временные 
диаграммы изображены для n = 0).  

В устройстве управления формируется интервальный импульс длитель-
ностью 10nTx (временная диаграмма U3 на рисунке 4.5), поступающий на один 
из входов логической схемы «И».  

В этом случае кварцевый генератор совместно с формирующим устрой-
ством вырабатывает короткие импульсы, следующие с периодом повторения Т0 
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(временная диаграмма U4 на рисунке 4.5), которые поступают на второй вход 
логической схемы «И» (временная диаграмма U4 на рисунке 4.5).  

 

 
Рисунок 4.4 – Структурная схема частотомера в режиме измерения периода  

 

 
Рисунок 4.5 – Временные диаграммы, поясняющие принцип измерения периода 

сигнала цифровым частотомером  
 

При одновременном воздействии импульсов U3 и U4 на входы логической 
схемы «И» на ее выходе появится последовательность коротких импульсов, 
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сформированных кварцевым генератором (временная диаграмма U5), количе-
ство которых NT подсчитывается счетчиком.  

В результате их количество  
 

0
0

10
10
10 fT

T
TN mn

Xm

n
X

T ⋅⋅=
⋅
⋅

= −     (4.3) 

 
будет равно измеряемому периоду. При f0 = 10 МГц Nт с коэффициентом 10nm 
равно периоду в секундах. Отсчет в миллисекундах или микросекундах получа-
ется переносом десятичной точки в отсчетном устройстве.  

Источники погрешности, возникающей при измерении периода, анало-
гичны измерению частоты. На низких частотах (ТХ достаточно велик) погреш-
ность дискретности стремится к «нулю» и доминирует погрешность, обуслов-
ленная нестабильностью периода счетных импульсов Т0. На высоких же часто-
тах (ТХ мало) δ0 становится пренебрежимо малой. Поэтому повысить точность 
измерения можно уменьшением периода Т0 (m = –1) или измерением не одного, 
а n периодов сигнала (n > 0) с последующим усреднением результатов измере-
ний. Кроме того, уменьшить погрешность дискретности можно применением 
нониусного метода, используемого при измерении временных интервалов.  

Измерение длительности импульса практически аналогично измерению 
периода (обе величины являются временными интервалами). Однако из схемы 
(см. рисунок 4.4) следует исключить делитель частоты, поскольку при n ≠ 0 
сигнал после делителя частоты будет иметь длительность, не связанную с изме-
ряемой. Количество счетных импульсов, поступивших на счетчик, при этом бу-
дет определяться следующим выражением:  

 
m

xm
x f

T
N −

τ ⋅⋅=
⋅
τ

= 10τ
10 0

0

.    (4.4) 

 
Источники погрешности оцениваются аналогично измерению периода. 

Однако при этом следует отметить, что при длительности фронта и среза изме-
ряемого импульса, сравнимым с f0, появляется дополнительная погрешность.  

Для измерения отношения частот используется структурная схема, при-
веденная на рисунке 4.6.  

Для повышения точности преобразования период сигнала ТХ2 можно уве-
личить в заданное число раз с помощью делителя частоты, увеличив в такое же 
число раз и время измерения частотомера.  

Действительно, если на вход 1 схемы подать импульсы с более высокой 
частотой f1, а на вход 2 – с более низкой f2, то, как это следует из формулы  
(4.1), количество импульсов, поступивших на счетчик, будет определяться  
выражением  

2

1

1

2

f
f

T
TN == ,      (4.5) 
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т. е. количество подсчитанных счетчиком импульсов N будет равно отношению 
частот двух сигналов. 

 

 
Рисунок 4.6 – Структурная схема цифрового частотомера в режиме измерения 

отношения частот двух сигналов 
 
 

4.3 Приборы, используемые для выполнения работы 
 
1. Персональный компьютер с операционной системой Windows 2000/XP, 

Windows Vista x64/x86, Linux®, Mac OS X.  
2. Плата сбора данных NI-DAQmx – NI PCI-6251.  
3. Соединительный кабель.  
4. Коннекторный блок. 
5. Программное обеспечение LabVIEW.  

 
4.4 Описание лабораторной установки  
 
Лабораторная установка, используемая при выпонении лабораторной ра-

боты, представляет собой совокупность персонального компьютера со встроен-
ной в него печатной платой сбора данных NI-DAQmx со следующими характе-
ристиками:  

– 16 аналоговых входов на 16 бит;  
– тактовая частота дискретизации АЦП 1,25 MS/s;  
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– 4 аналоговых выхода по 16 бит с разрешением 2,8 MS/s;  
– 7 программируемых входных диапазонов (от ±100 мВ до ±10 В) на канал;  
– 48 ТТЛ цифровых входных/выходных линий (10 MГц);  
– программное обеспечение LabVIEW, коннекторный блок CB-68LP и со-

единительный кабель SHC68-68-EPM.  
 
4.5 Подготовка к выполнению работы 
 
4.5.1 По рекомендуемой литературе детально изучите принцип действия 

компьютерно-измерительных систем, основные режимы их работы и методики 
выполнения измерений с их помощью параметров исследуемых сигналов и 
объектов.  

4.5.2 Изучите методики создания электронных осциллографов, регули-
ровки их параметров и проведения измерений параметров исследуемых сигна-
лов с их помощью с оценкой погрешностей полученных результатов.  

4.5.3 Сделайте заготовку отчета по лабораторной работе в соответствии с 
требованиями подраздела 4.8 настоящего учебно-методического пособия и объ-
емом лабораторного задания.  

4.5.4 Ответьте на контрольные вопросы.  
 
4.6 Задание к лабораторной работе 
 
4.6.1 Создайте компьютерно-измерительную систему с функциями часто-

томера и измерителя временных интервалов.  
4.6.2 Проведите измерение частотных и временных параметров сигналов, 

подаваемых с выхода виртуального генератора.  
4.6.3 Проведите оценку погрешности измерения заданных в пункте 4.6.2 

параметров сигнала.  
 
4.7 Порядок выполнения работы 
 
4.7.1 Выполните работу в соответствии с пунктом 4.6.1 лабораторного за-

дания. Работу рекомендуется проводить в следующей последовательности.  
Включите персональный компьютер. Запустите программное обеспече-

ние LabVIEW.  
Создайте компьютерно-измерительную систему с функциями генератора 

сигналов произвольной формы, лицевая панель которой представлена на ри-
сунке 4.7, а блок-диаграмма – на рисунке 4.8.  

Запустите компьютерно-измерительную систему путем нажатия кнопки 
Run (Пуск) на панели инструментов интерфейса.  

Установите с помощью элементов управления «Частота» и «Амплитуда», 
расположенных справа от графического индикатора, параметры генерируемого 
сигнала, заданные в соответствии с вариантом выполнения лабораторной рабо-
ты в таблице 4.1.  
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Рисунок 4.7 – Лицевая панель компьютерно-измерительной системы  
с функциями частотомера и измерителя временных интервалов  

 
Проведите наблюдение исследуемого сигнала и его спектра на индикато-

рах «Осциллографический индикатор» и «Анализатор спектра». Скопируйте 
наблюдаемые сигналы в память компьютера.  

 
Таблица 4.1 – Варианты задания значений параметров исследуемого сигнала  
Наименование  

параметра 
Номер варианта 

1 2 3 4 5 6 7 8 9 10 
Частота, кГц 100 110,2 120,1 140 150 160 170 180 190 90 
Амплитуда, В 1 2 3 4 5 6 7 8 9 10 

 
4.7.2 Выполните работу в соответствии с пунктом 4.6.2 лабораторного за-

дания. Работу рекомендуется проводить в следующей последовательности.  
Проведите измерение частоты и периода исследуемого сигнала по инди-

каторам «Частота» и «Период» с различным разрешением.  
Результаты измерений занесите в таблицу 4.2.  
Остановите генерацию исследуемого сигнала, нажав кнопку «Стоп» на 

лицевой панели ВП.  
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Рисунок 4.8 – Блок-диаграмма компьютерно-измерительной системы  
с функциями частотомера и измерителя временных интервалов 

 
4.7.3 Выполните работу в соответствии с пунктом 4.6.2 лабораторного за-

дания. Работу рекомендуется проводить в следующей последовательности. 
Определите погрешность измерения частоты и периода сигнала. Резуль-

таты расчетов занесите в таблицу 4.2.  
 

Таблица 4.2 – Результаты измерений параметров исследуемого сигнала 
Наименование  

параметра 
Заданное 
значение 

Измеренное  
значение 

Погрешность  
измерения 

Период, мкс    
Частота, кГц    
 

4.8 Содержание отчета 
 

4.8.1 Отчет по лабораторной работе должен содержать: титульный лист с 
указанием фамилии студента, номера группы и номера варианта выполняемого 
лабораторного задания, формулировку цели лабораторной работы, перечень за-
даний к выполнению лабораторной работы, перечень применяемого при вы-
полнении работы оборудования.  

4.8.2 В отчете необходимо привести структурную схему компьютерно-
измерительной системы и ее блок-диаграмму, а также осциллограммы полу-
ченных в результате выполнения работы сигналов измерительной информации.  
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4.8.3 Результаты измерений параметров сигналов (частота, период), полу-
ченных в результате выполнения работы, следует приводить в виде таблиц с 
оценкой погрешности измерения.  
 

4.9 Контрольные вопросы 
 
1. Дайте определение компьютерно-измерительной системе с функциями 

частотомера и измерителя интервалов времени. Какие функции она способна 
выполнять? 

2. Как происходит измерение частоты исследуемого сигнала с помощью 
компьютерно-измерительной системы?  

3. Как происходит измерение периода исследуемого сигнала с помощью 
компьютерно-измерительной системы?  

4. Перечислите основные методы измерения частотных и временных па-
раметров сигналов.  

5. В чем суть электронно-счетного метода измерения частоты, периода, 
длительности импульса, отношения частот? 

6. Перечислите основные источники погрешностей измерения частоты, 
периода, длительности импульса и отношения частот цифровым методом. По 
каким формулам можно оценить каждую из составляющих погрешности этих 
величин? 

7. Как в зависимости от значения измеряемого параметра и режимов ра-
боты частотомера изменяются составляющие погрешностей?  

8. Какие существуют способы повышения точности измерения частоты и 
периода ВЧ- и НЧ-сигналов? В чем суть каждого способа? 

9. Как оцениваются погрешности косвенных измерений с однократными 
наблюдениями? 
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5 ЛАБОРАТОРНАЯ РАБОТА №А4.  
КОМПЬЮТЕРНО-ИЗМЕРИТЕЛЬНАЯ СИСТЕМА С ФУНКЦИЯМИ 
ЦИФРОВОГО ФАЗОМЕТРА  
 
5.1 Цель работы: 
– изучение основных аналоговых и цифровых методов измерения фазо-

вых сдвигов; 
– создание компьютерно-измерительной системы с функциями цифрового 

фазометра и приобретение практических навыков работы с ним;  
– проведение измерения фазовых сдвигов между двумя синусоидальными 

колебаниями и оценка погрешности их измерения.  
 
5.2 Основные теоретические положения 

 
Наряду с амплитудными и частотными параметрами измерение фазовых 

параметров сигналов, элементов и узлов аппаратуры, линий связи и трактов пе-
редачи является одним из наиболее распространенных видов измерений, осо-
бенно в радиоэлектронике, информатике и технике связи. Их знание необходи-
мо для обеспечения безыскаженной передачи информации и становится осо-
бенно важным при передаче любой информации на большие расстояния. Кроме 
того, с помощью фазовых параметров очень часто оценивают качество самых 
различных устройств радиоэлектроники, информатики и связи. 

Чаще всего целью фазовых измерений являются фазовые параметры, кото-
рые характеризуют конкретное устройство (усилитель, преобразователь, линия 
связи, тракт передачи и т. д.). К ним относятся фазовый сдвиг и фазовые искаже-
ния, характеризующие прохождение сигнала через какое-либо устройство.  

Фазовый сдвиг – это изменение фазы сигнала при прохождении его через 
устройство, и определяется он как модуль разности начальных фаз сигналов на 
выходе и входе этого устройства: 

 
ϕX = ϕВЫХ – ϕВХ.                                                  (5.1) 

 
Отклонение же частотной характеристики фазового сдвига (ФЧХ 

устройства) от линейности называют фазовыми искажениями. Количествен-
ная оценка фазовых искажений производится с помощью группового време-
ни запаздывания (ГВЗ). Различают абсолютное и относительное ГВЗ. Абсо-
лютное ГВЗ определяется не только характером ФЧХ устройства, но и физи-
ческой длиной тракта передачи сигнала, т. е. характерно для линии связи 
большой протяженности. 
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Наибольшее распространение на практике получили следующие методы 
измерения фазовых сдвигов: 

– метод суммы и разности напряжений; 
– нулевой метод; 
– метод преобразования фазового сдвига во временной интервал; 
– осциллографический метод.  
Как и частотно-временные измерения, фазовые измерения могут быть аб-

солютными и относительными. Задачей абсолютных изменений является коли-
чественная оценка значений фазовых сдвигов ϕХ, а задачей относительных из-
мерений – определение их изменений. Изменение фазового сдвига ϕХ носит 
случайный характер и чаще всего обусловлено флюктуациями начальной фазы 
сигнала. Измерение флюктуации фазовых сдвигов сигналов относится уже к 
числу задач, которые решаются методами измерения характеристик случайных 
сигналов и в этом разделе не рассматриваются. Отметим только, что помимо 
фазометров разрабатываются такие специализированные приборы, как стати-
стические анализаторы флюктуаций фазы, анализаторы функций корреляции 
фазы и анализаторы спектра флюктуаций фазы.  

 
Метод преобразования фазового сдвига в интервал времени 

 
Сущность метода заключается в преобразовании фазового сдвига ϕX меж-

ду двумя гармоническими сигналами U1 и U2, который необходимо измерить, в 
пропорциональный ему интервал времени ∆tX. Затем измеряется отношение ∆tX 
к периоду сигналов TX. Математически это выглядит таким образом:  

 

ϕХ = ω⋅∆tX и 
X

о

Х TТ
3602

=
π

=ω ,  

т. е.  

X

X
X T

t∆
⋅=ϕ o360 .                                                 (5.2) 

 
Суть преобразования наглядно поясняется следующими эпюрами 

(рисунок 5.1). Если гармонические сигналы U1 и U2 (рисунок 5.1, а) с помощью 
формирующих устройств (аналогично используемым в цифровых частотоме-
рах) преобразовать в последовательности коротких импульсов 1U ′  и 2U ′ , соот-
ветствующие моментам перехода этих сигналов через нуль (рисунок 5.1, б, в 
соответственно), то полученный интервал времени ∆tX между ближайшими им-
пульсами одной полярности будет пропорционален измеряемому значению фа-
зового сдвига ϕX (рисунок 5.1, г).  

Как видно из рисунка 5.1, г, отношение ∆tX/TX может быть определено как 
постоянная составляющая периодической последовательности прямоугольных 
импульсов и легко измерена аналоговым или цифровым вольтметром. Если же 
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∆tX необходимо преобразовать в цифровой код, то это также легко сделать с 
помощью селектора, управляемого импульсами ∆tX. Таким образом, во всех фа-
зометрах (аналоговых и цифровых), реализующих этот метод, предусматрива-
ется образование из 1U ′  и 2U ′  периодической последовательности прямоуголь-
ных импульсов длительностью ∆tX. Наиболее часто это на практике осуществ-
ляется с помощью триггеров и поэтому такие фазометры в технической литера-
туре называют триггерными.  
 

 
Рисунок 5.1 – Временные диаграммы, поясняющие метод преобразования 

фазового сдвига во временной интервал  
 

На практике существуют и другие типы преобразователей. Более того, в 
практических схемах фазометров могут фиксироваться моменты переходов U1 
и U2 через нуль не только в одном положительном направлении, но и в проти-

Би
бл
ио
те
ка

 БГ
УИ
Р



 81 

воположном отрицательном (как на рисунке 5.1, б, в). Такие фазометры назы-
ваются двухполупериодными. Это позволяет уменьшить погрешность измере-
ния ϕХ за счет искажения формы сигналов U1 и U2. 

Современные фазометры, реализующие этот метод преобразования ϕХ в 
∆tX, в подавляющем большинстве являются цифровыми (ЦФ). Все варианты 
схем ЦФ во многом аналогичны ЦВ, реализующим времяимпульсный метод 
преобразования. Среди них, как и среди ЦВ и ЦЧ, можно выделить: 

– неинтегрирующие ЦФ (измеряют мгновенное значение фазового сдвига 
ϕХ за один период исследуемых сигналов ТХ); 

– интегрирующие ЦФ (измеряют среднее значение ϕХ за выбранный ин-
тервал времени измерения ТИ. При этом ТИ >> ТX). 

 
Неинтегрирующие ЦФ 

 
Упрощенная структурная схема однополупериодного неинтегрирующе-

го ЦФ, реализующая алгоритм преобразования ϕХ в ∆tX в соответствии с выра-
жением (5.2), имеет следующий вид (рисунок 5.2).  

 

 
 

Рисунок 5.2 – Структурная схема однополупериодного неинтегрирующего ЦФ 
 

Работа всех функциональных узлов нам уже известна. Отметим только, 
что с помощью УУ не только обеспечивается синхронная работа всех узлов, но 
и ограничивается время измерения ϕХ значением ТХ. 

Чтобы получить значение отношения ∆tX/TX, измерение должно прово-
диться в два этапа: измерение ∆tX (П в положении 1) и измерение TX (П в поло-
жении 2). При первом измерении на выходе селектора будет пачка импульсов 
U4 (рисунок 5.1, д). Счетчик зафиксирует число импульсов в пачке NϕХ с учетом 
(5.2): 

x Х Х

0 0

t TN
T T360Хϕ

ϕ
= = ⋅





∆ ,                                              (5.3) 

 
где T0 – период следования импульсов ГСИ.  
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Как видно из рисунка 5.1, д и полученного выражения (5.3), между Nϕx и 
ϕX прямо пропорциональная связь, и так как остальные величины постоянны, то 
можно получить значение ϕX: 

 

Х

0
Х

oo
Х T

TN ⋅⋅=ϕ ϕ360 .                                                    (5.4) 

 
Зачем же измерять TX и определять отношение? Это необходимо, чтобы 

исключить зависимость ХNϕ  от TX, так как выражение (5.4) справедливо только 
для ТХ = const, т. е. измерения можно проводить только на одной фиксирован-
ной частоте.  

При втором измерении  
 

0T
TN Х

T =  и 0TNT TХ ⋅= .                                         (5.5) 

Для вычисления ϕХ после подстановки значения ТХ из (5.4) в (5.5) получа-
ем окончательно: 

T

Хo
Х N

Nϕ⋅=ϕ 360 .                                                (5.6) 

 
Таким образом, рассмотренный ЦФ является фактически комбинирован-

ным прибором (фазометр-частотомер) и имеет существенные недостатки. От-
метим основные способы устранения этих недостатков, позволяющие создавать 
прямоотсчетные неинтегрирующие ЦФ. 

Первый способ виден из соотношения (5.4) и реализуется с помощью 

арифметического устройства, осуществляющего операцию деления 
TN

N
Хϕ  и по-

следующего умножения на 360°. Этапы измерения Хt∆  и ХT  можно совместить 
во времени за счет усложнения схемы ЦФ.  

Второй способ имеет несколько схемных модификаций, но все они 
направлены на достижение кратности периодов ХT  и 0T . Если в формуле (5.4) 
отношение n

Х TT 1036/ 0 ⋅= , где n = 1, 2, 3,… , то получим прямоотсчетный ЦФ. 
Здесь возможны также два варианта: 

– образование счетных импульсов с периодом следования n
ХTT
10360 ⋅

= ; 

– образование счетных импульсов с периодом следования T0 = TX при од-
новременном увеличение времени измерения ТИ в n1036 ⋅  раз. 

В заключение отметим, что погрешность измерения ϕХ при наличии по-
мех возрастает, как и у неинтегрирующих ЦВ. Избавиться от этого можно, 
применив интегрирующий ЦФ.  
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Интегрирующие ЦФ 
 
Упрощенная структурная схема однополупериодного интегрирующего 

цифрового фазометра (ИЦФ), реализующая алгоритм ϕX → ∆tX → цифровой 
код, представлена на рисунке 5.3.  

 

 
Рисунок 5.3 – Структурная схема цифрового фазометра 

 
Как видно из схемы (см. рисунок 5.3), на выходе первой логической схе-

мы «И» образуются пачки счетных импульсов (рисунок 5.1, д). Количество им-
пульсов в пачке равно Nϕ и определяется выражением (5.6). Эти пачки посту-
пают на вход второй логической схемы «И», которая пропускает на свой выход 
пачки импульсов только во время действия стробирующего импульса U5 (рису-
нок 5.1, е). Этот импульс формируется в УУ из импульсов ГСИ путем пониже-
ния их частоты следования в 36⋅10n раз с помощью делителя частоты. Таким 
образом, TИ = T0⋅36⋅10n и обеспечивается выполнение необходимой кратности 
между TИ и Т0. 

Число пачек счетных импульсов на выходе второй логической схемы «И» 
(рисунок 5.1, ж) равно  

 
И И /T ХN T T= .  (5.7) 

 
В результате счетчик фиксирует число импульсов N, равное 

 
 

xT TN N N
и иϕ= ⋅ .   
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С учетом (5.7) 

Х

0

TN
T360
Иϕ

= ⋅




 и 
И

0oo 360
T
TNХ ⋅⋅=ϕ .                                   (5.8) 

 
Как видно из выражения (5.8), число импульсов N прямо определяет из-

меряемое значение ϕX, так как ТИ и Т0 – величины постоянные. Значение ϕX 
также не зависит от периода сигналов TX. 

Преимущества ИЦФ по сравнению с неинтегрирующим: 
– независимость результатов измерения ϕX от периода TX; 
– уменьшение погрешности измерения ϕX при наличии помех; 
– уменьшение погрешности дискретности в 

ИТN  раз и увеличение во 
столько же раз верхней границы диапазона рабочих частот фазометра в гомо-
динном варианте. 

Дальнейшее расширение диапазона частот требует применения гетеро-
динного преобразования частоты, как и для ЦЧ. 

Основным недостатком ИЦФ является пониженное быстродействия, по-
скольку для получения высоких метрологических характеристик требуется 
обеспечение условия ТИ >> ТХ. 

 
5.3 Приборы, используемые для выполнения работы 
 
1. Персональный компьютер с операционной системой Windows 2000/XP, 

Windows Vista x64/x86, Linux®, Mac OS X.  
2. Плата сбора данных NI-DAQmx – NI PCI-6251. 
3. Соединительный кабель.  
4. Коннекторный блок. 
5. Программное обеспечение LabVIEW.  
 
5.4 Описание лабораторной установки  
 
Лабораторная установка, используемая при выполнении лабораторной 

работы, представляет собой совокупность персонального компьютера со встро-
енной в него печатной платой сбора данных NI-DAQmx со следующими харак-
теристиками:  

– 16 аналоговых входов на 16 бит;  
– тактовая частота дискретизации АЦП 1,25 MS/s;  
– 4 аналоговых выхода по 16 бит с разрешением 2,8 MS/s;  
– 7 программируемых входных диапазонов (от ±100 мВ до ±10 В) на канал;  
– 48 ТТЛ цифровых входных/выходных линий(10 MГц),  
– программное обеспечение LabVIEW, коннекторной блок CB-68LP и со-

единительный кабель SHC68-68-EPM.  
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5.5 Подготовка к выполнению работы 
 
5.5.1 По рекомендуемой литературе детально изучите принцип действия 

компьютерно-измерительных систем, основные режимы их работы и методики 
выполнения измерений с их помощью параметров исследуемых сигналов и 
объектов.  

5.5.2 Изучите методики создания аналоговых и цифровых фазометров, ре-
гулировки их параметров и проведения измерений параметров исследуемых 
сигналов с их помощью с оценкой погрешностей полученных результатов.  

5.5.3 Сделайте заготовку отчета по лабораторной работе в соответствии с 
требованиями подраздела 5.8 настоящих методических указаний и объемом ла-
бораторного задания.  

5.5.4 Ответьте на контрольные вопросы.  
 
5.6 Задание к лабораторной работе 

 
5.6.1 Создайте компьютерно-измерительную систему с функциями циф-

рового фазометра.  
5.6.2 Проведите измерение фазовых сдвигов двух сигналов, подаваемых с 

выходов виртуальных генераторов.  
5.6.3 Проведите оценку погрешности измерения заданных в пункте 5.6.2 

параметров сигнала.  
 
5.7 Порядок выполнения работы 
 
5.7.1 Выполните работу в соответствии с пунктом 5.6.1 лабораторного за-

дания. Работу рекомендуется проводить в следующей последовательности.  
Включите персональный компьютер. Запустите программное обеспечение 

LabVIEW.  
Создайте компьютерно-измерительную систему с функциями генератора 

сигналов произвольной формы, лицевая панель которой представлена на ри-
сунке 5.4, а блок-диаграмма – на рисунке 5.5.  

Запустите компьютерно-измерительную систему путем нажатия кнопки 
Run (Пуск) на панели инструментов интерфейса. Также можно нажать комби-
нацию клавиш <Ctrl-R>. В случае возникновения затруднений воспользуйтесь 
сведениями, приведенными в разделе 1 настоящего учебно-методического по-
собия.  

Установите с помощью элементов управления «Амплитуда 1», «Часто-
та 1» и «Начальная фаза 1» параметры первого исследуемого сигнала, заданные 
в соответствии с вариантом выполнения лабораторной работы в таблице 5.1.  

Установите с помощью элементов управления «Амплитуда 2», «Часто-
та 2» и «Фазовый сдвиг 2» параметры второго исследуемого сигнала, заданные 
в соответствии с вариантом выполнения лабораторной работы в таблице 5.1.  
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Рисунок 5.4 – Лицевая панель компьютерно-измерительной системы  
с функциями цифрового фазометра  

 
Пронаблюдайте на экране осциллографического индикатора «Waveform 

Graph» изображения исследуемых сигналов, а на индикаторе «XY Graph» – их 
интерференционную картину. Скопируйте наблюдаемые сигналы в память 
компьютера.  

 
Таблица 5.1 – Варианты задания значений фазовых сдвигов сигналов  

Номер варианта 1 2 3 4 5 6 7 8 9 10 
Амплитуда 1, В 1 2 3 4 5 6 7 8 9 10 
Частота 1, Гц 10 20 30 40 50 60 70 80 90 100 
Фазовый сдвиг 1, 
град  

 
15 

 
25 

 
43 

 
56 

 
77 

 
89 

 
120 

 
180 

 
90 

 
270 

Амплитуда 2, В 1 2 3 4 5 6 7 8 9 10 
Частота 2, Гц 10 20 30 40 50 60 70 80 90 100 
Фазовый сдвиг 2, 
град  

 
270 

 
15 

 
43 

 
90 

 
120 

 
77 

 
180 

 
89 

 
25 

 
56 

 
5.7.2 Выполните работу в соответствии с пунктом 5.6.2 лабораторного за-

дания. Работу рекомендуется проводить в следующей последовательности. 
Проведите измерение амплитудных, частотных и фазовых параметров исследу-
емых сигналов.  
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Рисунок 5.5 – Блок-диаграмма компьютерно-измерительной системы  

с функциями цифрового фазометра  
 

Проведите измерение фазовых сдвигов исследуемых сигналов с помощью 
известных вам методов измерения фазовых сдвигов. Результаты измерений за-
несите в таблицу 5.2.  

 
Таблица 5.2 – Результаты измерений фазовых сдвигов заданных сигналов 

Наименование параметра Заданное 
значение 

Измеренное 
значение 

Погрешность 
измерения 

Фазовый сдвиг, град    
Фазовый сдвиг плюс 10, град    
Фазовый сдвиг минус 10, град    
 

Измените значение заданного вам «Фазового сдвига 1» на плюс 10°.  
Проведите измерение фазовых сдвигов исследуемых сигналов с помощью 

известных вам методов измерения фазовых сдвигов. Результаты измерений за-
несите в таблицу 5.2.  

Измените значение заданного вам «Фазового сдвига 1» на минус 10°.  
Остановите генерацию исследуемых сигналов, нажав кнопку «Стоп» на 

лицевой панели ВП.  
5.7.3 Выполните работу в соответствии с пунктом 5.6.3 лабораторного за-

дания. Работу рекомендуется проводить в следующей последовательности.  
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Определите погрешность измерения фазовых сдвигов исследуемых сиг-
налов в зависимости от выбранного метода измерения фазовых сдвигов. Ре-
зультаты расчетов занесите в таблицу 5.2.  

 
5.8 Содержание отчета 

 
5.8.1 Отчет по лабораторной работе должен содержать: титульный лист с 

указанием фамилии студента, номера группы и номера варианта выполняемого 
лабораторного задания, формулировку цели лабораторной работы, перечень за-
даний к выполнению лабораторной работы, перечень применяемого при вы-
полнении работы оборудования.  

5.8.2 В отчете необходимо привести структурную схему компьютерно-
измерительной системы и ее блок-диаграмму, а также осциллограммы полу-
ченных в результате выполнения работы сигналов измерительной информации.  

5.8.3 Результаты измерений фазовых сдвигов, полученных в результате 
выполнения работы, следует приводить в виде таблиц с оценкой погрешности 
измерения.  

 
5.9 Контрольные вопросы 
 
1. Что понимают под фазовым сдвигом двух гармонических колебаний?  
2. Какое математическое выражение положено в основу измерения фазо-

вого сдвига между двумя гармоническими сигналами при реализации метода 
суммы и разности напряжений?  

3. Каким способом производится исключение неоднозначности отсчета 
значений фазового сдвига при его измерении фазометром, в основу работы ко-
торого положен метод суммы и разности напряжений?  

4. Отсчет измеренного значения фазового сдвига в фазометре, реализую-
щим нулевой метод, производится по шкале:  

а) индикаторного прибора;  
б) измерительного фазовращателя;  
в) установочного фазовращателя.  
Укажите правильный ответ. 
5. Какое математическое выражение положено в основу измерения фазо-

вого сдвига между двумя гармоническими сигналами при реализации метода 
преобразования фазового сдвига во временной интервал? 

6. Приведите математическое выражение, связывающее измеряемое зна-
чение фазового сдвига с постоянной составляющей последовательности им-
пульсных сигналов прямоугольной формы, при реализации метода преобразо-
вания фазового сдвига во временной интервал. 

7. Приведите структурную схему фазометра, в основу работы которого 
положен метод суммы и разности напряжений. Поясните принцип и опишите с 
помощью математических выражений алгоритм ее работы.  
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8. Укажите причины возникновения погрешности измерения фазовых 
сдвигов в фазометре, реализующем метод суммы и разности напряжений. Оце-
ните значение погрешности измерения фазовых сдвигов в градусах.  

9. Приведите структурную схему фазометра, в основу работы которого 
положен нулевой метод. Поясните принцип ее работы.  

10. С какой целью в структурную схему фазометра, реализующего нуле-
вой метод измерения фазовых сдвигов, введен установочный фазовращатель?  

11. Чем обусловлена погрешность измерения фазовых сдвигов фазомет-
ром, в основу работы которого положен нулевой метод?  

12. Оцените погрешность измерения фазового сдвига между двумя гармо-
ническими сигналами, если его измерение производилось с помощью фазометра, 
реализующего нулевой метод. Результат измерения равен 97°, цена деления шка-
лы измерительного фазовращателя – 0,5°. Запишите результат измерения.  

13. Какие типы индикаторных приборов используются в фазометрах, реа-
лизующих метод суммы и разности напряжений и нулевой метод?  

14. Приведите структурную схему фазометра, реализующего метод пре-
образования фазового сдвига во временной интервал, и поясните принцип его 
работы с использованием временных диаграмм и математических выражений. 

15. Чем обусловлена погрешность измерения фазовых сдвигов фазометром, 
реализующим метод преобразования фазовых сдвигов во временной интервал?  

16. Каким образом осуществляется преобразование фазовых сдвигов в 
пропорциональный им интервал времени? Приведите возможные структурные 
схемы таких преобразователей. 

17. Как производится измерение временных интервалов, пропорциональ-
ных фазовому сдвигу, в цифровых фазометрах, реализующих следующие алго-
ритмы преобразования: ∆ϕХ → ∆tХ → UХ – цифровой код и ∆ϕХ → ∆tХ → цифро-
вой код.  
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